Notice

The information contained in this document is subject to change without notice.

Agilent Technologies makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Agilent Technologies shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material.

Warranty

A copy of the specific warranty terms that apply to this software product is available upon request from your Agilent Technologies representative.

Restricted Rights Legend

Use, duplication or disclosure by the U. S. Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 for DoD agencies, and subparagraphs (c) (1) and (c) (2) of the Commercial Computer Software Restricted Rights clause at FAR 52.227-19 for other agencies.

Agilent Technologies
395 Page Mill Road
Palo Alto, CA 94304 U.S.A.


Acknowledgments

Mentor Graphics is a trademark of Mentor Graphics Corporation in the U.S. and other countries.

Microsoft®, Windows®, MS Windows®, Windows NT®, and MS-DOS® are U.S. registered trademarks of Microsoft Corporation.

Pentium® is a U.S. registered trademark of Intel Corporation.

PostScript® and Acrobat® are trademarks of Adobe Systems Incorporated.

UNIX® is a registered trademark of the Open Group.

Java™ is a U.S. trademark of Sun Microsystems, Inc.
Contents

1 Before You Begin
   Note the Changes in ADS 2003C............................................................... 1-2
   Check the System Requirements........................................................... 1-3
   Check the Supported Instrument Interfaces........................................... 1-5
   Get Codewords for ADS 2003C............................................................... 1-6
   Backup Your Data.................................................................................. 1-7
   Check Available Memory...................................................................... 1-7
   Check Available Disk Space................................................................. 1-9

2 Installing Advanced Design System
   Installation Overview ............................................................................ 2-2
   Installation Steps .................................................................................. 2-3
      Typical Installation List...................................................................... 2-10
      Custom Installation List..................................................................... 2-11
   Configuring User Accounts................................................................. 2-14
      Setting the Display........................................................................... 2-15
   Installing to Multiple Disk Partitions or Directories.............................. 2-16
   Using Multiple ADS Versions............................................................... 2-18
      Setting the HOME Environment Variable........................................ 2-18
   Installing Connection Manager......................................................... 2-19

3 Setting Up Licenses
   Installing Licenses................................................................................ 3-2
      Save the License File........................................................................ 3-3
      Edit the License File.......................................................................... 3-3
      Place License File............................................................................ 3-11
      Start the License Server (lmgrd)........................................................ 3-12
      Provide Access to Licenses............................................................... 3-15
   Using a UNIX-to-PC Floating License.................................................. 3-17
   Automating FLEXlm License Manager Startup...................................... 3-17
   Selecting a License Bundle.................................................................. 3-19
   Special Licensing Needs....................................................................... 3-20
      Using FLEXlm Options..................................................................... 3-20
      Updating the License File................................................................ 3-23
   Merging Multiple Vendor Licenses....................................................... 3-23
   Redundant License Servers.................................................................. 3-27
      Controlling License Path Settings................................................... 3-27
   Managing Multiple ADS Versions....................................................... 3-31
   Backward Compatibility of Codewords............................................... 3-31
   Combining ADS 2003C Codewords with Other Agilent EEsof EDA Codewords 3-32
Example of a Merged License File ................................................................. 3-34
Using the Agilent License Information Tool .................................................. 3-37

4 Using Advanced Design System
Running Advanced Design System ................................................................. 4-1
  Using the Agilent License Preference Tool .................................................. 4-1
Starting ADS in Verbose Mode (Debug Mode) .............................................. 4-7
If ADS Does Not Start .................................................................................. 4-8
Common Licensing Problems .................................................................... 4-9
  Where to Begin ......................................................................................... 4-9
  Common Errors and Solutions ............................................................... 4-10
Printing and Plotting ................................................................................ 4-15
  Printing From UNIX ................................................................................ 4-15
  Adding a Printer ...................................................................................... 4-15
Agilent EEsof Technical Support ................................................................. 4-20

5 Using Remote Simulation
Using Remote Simulation on Linux ............................................................. 5-2
  System Requirements ............................................................................. 5-2
  Installing ADS on Linux Systems .......................................................... 5-3
Setting up Your Simulation Server ............................................................. 5-4
  Setting up a UNIX Server ....................................................................... 5-4
  Setting up a PC Server ........................................................................... 5-6
Setting up a UNIX Client ............................................................................ 5-7
  Multiple Servers ..................................................................................... 5-8
Scripting ...................................................................................................... 5-8
  Simulator Server Error ........................................................................... 5-9
  Remote Simulation Error ........................................................................ 5-9
Ending Remote Operation ........................................................................... 5-10
Remote Simulation Restrictions ................................................................. 5-10
Defining the EMX Daemon Remote Address ............................................. 5-11
Using LSF Remote Simulation .................................................................. 5-12
  LSF Requirements ................................................................................ 5-13
Setting Up LSF and ADS .......................................................................... 5-14
Chapter 1: Before You Begin

Before you begin, please take the time to go over the guidelines for installing Advanced Design System (ADS) on a UNIX system. For last-minute installation information, see the file readme.htm, included on the installation disk. For last-minute program and documentation information, refer to the Release Notes document on our website at:

http://www.agilent.com/find/eesof-docs

Choose Advanced Design System 2003C > Manuals > Release Notes
Before You Begin

Note the Changes in ADS 2003C

Important  If you have systems running older versions of ADS, see Table 1-1 for a brief description of changes in recent ADS versions and their impact on systems with older versions installed.

<table>
<thead>
<tr>
<th>Description and Reference to Details</th>
<th>Version Introduced and Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Packages are replaced by Bundles. The Bundle licenses work only if users select them by running the Agilent License Preference tool prior to starting ADS. See “Using the Agilent License Preference Tool” on page 4-1.</td>
<td>ADS 2003A Impacts all license servers using license bundles. This does not impact node-locked and floating-license files.</td>
</tr>
<tr>
<td>The FLEXlm version for license server (lmgrd) is 8.2a. See “Start the License Server (lmgrd)” on page 3-12.</td>
<td>ADS 2003A Impacts all systems, and license administration scripts.</td>
</tr>
<tr>
<td>The vendor daemon changed from agileesof to agileesofd, and the environment variable AGILEESOF_LICENSE_FILE changed to AGILEESOFD_LICENSE_FILE. See “Installing Licenses” on page 3-2.</td>
<td>ADS 2003A Impacts all license servers and client systems.</td>
</tr>
<tr>
<td>The main application name changed from hpads.exe to ads.exe. The command to start ADS changed to ads. See “Running Advanced Design System” on page 4-1.</td>
<td>ADS 2003A Impacts all users who start ADS, and startup scripts.</td>
</tr>
<tr>
<td>The codeword version changed from 2.0 to 2.3. The codewords are version-dependent. They will enable ADS 2003A and 2003C only. See “Installing Licenses” on page 3-2.</td>
<td>ADS 2003A You must obtain new FLEXlm license codewords from Agilent EEsof EDA.</td>
</tr>
<tr>
<td>Supported platforms changed. See “Check the System Requirements” on page 1-3.</td>
<td>ADS 2003A Solaris 9 support is added. IBM AIX is no longer supported.</td>
</tr>
<tr>
<td>ADS is supported on Linux only for remote simulation. For details about installing and using ADS on Linux, see “Using Remote Simulation on Linux” on page 5-2.</td>
<td>ADS 2003C Red Hat Linux support is added only for remote simulation.</td>
</tr>
</tbody>
</table>
Check the System Requirements

Be sure your hardware and software configuration meets the following minimum hardware and system requirements to install and/or run Advanced Design System, including RAM, disk space, operating systems, patches and updates, etc. Keep in mind that minimum requirements are just that, and they may not provide adequate performance and responsiveness.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Sun SPARC</th>
<th>HP 9000-700</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>SunOS 5.7, 5.8, and 5.9</td>
<td>HP-UX 11.0 and 11i ††</td>
</tr>
<tr>
<td></td>
<td>Solaris 7, 8, 9 †</td>
<td></td>
</tr>
<tr>
<td>Displays</td>
<td>High-resolution color only.</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>ADS is not supported on Intel Itanium-based workstations.</td>
<td></td>
</tr>
<tr>
<td>RAM</td>
<td>128 MB RAM recommended minimum, additional RAM will improve performance.</td>
<td></td>
</tr>
<tr>
<td>Swap Space</td>
<td>300 MB recommended minimum, increased swap space may be required for larger designs.</td>
<td></td>
</tr>
<tr>
<td>Web Browser</td>
<td>ADS documentation is HTML-based and displayed via a web browser. ADS installs Netscape 4.7x, and Agilent recommends that you use this installed version. If you use a different version, Netscape version 4.5 or higher is required. Make sure any older, unsupported versions you may have are not in your path ahead of the ADS installation.</td>
<td>Java Virtual Machine and JavaScript must be enabled on your browser for the documentation to appear correctly. You may need to download and install a Java plug-in.</td>
</tr>
</tbody>
</table>

† Sun Notes:
- Sun operating systems are not supported on Intel-compatible chips.
- Solaris 8 operating systems that do not include the C/C++ compiler require the following patch to install and run RFDE:
  - C++ Runtime Library patch for Solaris 8
  - 108434-13 32-Bit Shared library patch for C++
  - 108435-13 64-Bit Shared library patch for C++
  - Patches are available at http://sunsolve.sun.com/pub-cgi/show.pl?target=patchrpts/8

†† HP-UX Notes:
- HP-UX requires the following patches:
  - PHSS_24627 HP aC++ - AA Runtime Libraries (aCC A.03.33)
  - PHSS_25718 LIBCL
  - Patches are available at http://www2.itrc.hp.com/service/patch/mainPage.do
Before You Begin

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Sun SPARC</th>
<th>HP 9000-700</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard Disk Space</td>
<td>335 MB for a minimum installation, 1.7 GB for a typical installation, and 2.7 GB for a complete installation.</td>
<td></td>
</tr>
<tr>
<td>Security Device</td>
<td>An Advanced Design System software codeword is locked to an individual computer ID number.</td>
<td></td>
</tr>
<tr>
<td>Supported Printers/Plotters</td>
<td>ADS uses Xprinter for all PostScript®, HPGL2 and PCL printing. For a complete list of output devices supported with Xprinter, consult the text file called filename_map.txt, located in the directory path: &lt;installation directory&gt;/xprinter/ppds. For instructions on UNIX printing and plotting, refer to “Printing and Plotting” on page 4-15 in Chapter 4, Using Advanced Design System.</td>
<td></td>
</tr>
<tr>
<td>Supported Media Type</td>
<td>CD-ROM required for program installation.</td>
<td></td>
</tr>
<tr>
<td>Window Manager</td>
<td>Motif™ V.1.1/1.2 Open Windows 3.0, or CDE</td>
<td>HP VUE or CDE/ X-Windows V.X11R5</td>
</tr>
<tr>
<td>Compiler</td>
<td>For SunOS 5.7, 5.8, 5.9 or Solaris 7, 8, 9 SPARCompiler C++ Version 5.x (Forte Workshop 6 Update 2) or higher</td>
<td>For HP-UX 11 HP aC++, Version A.03.33 or higher, and HP C/ANSI C, Version B.11.11.04 or higher</td>
</tr>
</tbody>
</table>
| HDL simulator (required only for HDL cosimulation) | These HDL simulators are the latest versions supported on ADS:  
- ModelSim/PLUS™ EE V5.2e  
- Verilog® XL Version 3.11  
- NC-SIM Version 3.2 |                                                                             |

† Sun Notes:  
- Sun operating systems are not supported on Intel-compatible chips.  
- Solaris 8 operating systems that do not include the C/C++ compiler require the following patch to install and run RFDE:  
  C++ Runtime Library patch for Solaris 8  
  108434-13 32-Bit Shared library patch for C++  
  108435-13 64-Bit Shared library patch for C++  
  Patches are available at http://sunsolve.sun.com/pub-cgi/show.pl?target=patchrpts/8

†† HP-UX Notes:  
- HP-UX requires the following patches:  
  PHSS_24627 HP aC++ -A.A Runtime Libraries (aCC A.03.33)  
  PHSS_25718 LIBC  
  Patches are available at http://www2.itrc.hp.com/service/patch/mainPage.do
Checking the Operating System
To determine the version that you are currently running, at the system prompt type:

```bash
uname -r (All UNIX platforms)
```

Check the Supported Instrument Interfaces
For details on configuring and using the various instrument interfaces supported by Advanced Design System, please refer to the latest list of supported instruments at:

http://www.agilent.com/find/eesof-docs

Choose Advanced Design System 2003C > Manuals > Design and Display > Using Instruments
Before You Begin

Get Codewords for ADS 2003C

You must obtain new FLEXlm license codewords to run Advanced Design System 2003C. While you can install any component, you will be able to run only those for which you have a license. For details about license codewords required for simulators, design library components, and other ADS products, see the ADS License Dependency Table at:

http://www.agilent.com/find/eesof-license-dependencies

A Codeword Request form is included with your installation media. Please fill it out completely and fax it to the number on the form. You can also ask for licenses or codewords on the Web at:

http://www.agilent.com/find/eesof-support

Choose Codeword Request

The codewords are emailed to you in a license file called licenselic.

The hardware key is generally shipped with the software disks. If you do not have one, contact Agilent EEsof Business Support at 1-800-507-6274.

For details on both methods of securing codewords refer to Chapter 3, Setting Up Licenses.

---

**Important** For HP-UX 11.x systems from Agilent, avoid keying licenses to the LAN ID/MAC address. Macrovision does not recommend using an Ethernet address for the hostid on HP-UX 11.x systems.

---
Backup Your Data

You can retain earlier installations of Advanced Design System and ADS 2003C in separate directories on the same machine, but you cannot install version 2003C over a previous Advanced Design System installation. This also applies to an Early Access (Beta) 2003C version.

Before you delete a previous installation:

- Copy your projects, customized configuration files, and other data.
- Copy your license file from the <install_dir>/licenses directory.

For details on running multiple ADS versions, refer to “Using Multiple ADS Versions” on page 2-18 in Chapter 2, Installing Advanced Design System.

Check Available Memory

You need a minimum of 128 MB of memory installed on your system. More memory results in better overall system performance for some design work.

SUN Workstations

To check the amount of memory on your system, enter the following command at a UNIX prompt:

/etc/dmesg | more (SunOS 5.x etc)
/usr/bin/dmesg | more (Solaris 7/8/9)

Look for the “avail mem=” and “mem=” lines.
This command lists the messages displayed during the last boot of the system.
Before You Begin

**HP Workstations**

To check the amount of memory on your system, enter the following command at a UNIX prompt:

```
/etc/dmesg
```

Look for the “Memory Information” line.

By default, HP-UX limits a single application’s memory allocation to 65 megabytes. To allocate more memory for a single process, use `sam` (System Administration Manager) to reconfigure the kernel parameters `maxdsiz`, `maxtsiz` and `maxssiz` to maximize the system’s ability to allocate and use the available memory resources.

For example, if your system has 128 MB of physical RAM and 500 MB of swap space, you would need to adjust the `maxdsiz` and `maxtsiz` kernel parameters to:

```
<Total RAM> + <Total Swap> = 128 + 500 = 628 MB
```

The `maxssiz` kernel parameter should be adjusted to approximately 12% of the `maxdsiz` value, or its maximum.
Check Available Disk Space

The amount of disk space required depends on the Advanced Design System products that you wish to install. Approximately 2.7 GB of disk space is required to install all Advanced Design System products. To display the available disk space, at the prompt enter the command for the workstation you are using:

<table>
<thead>
<tr>
<th>Workstation</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP UX 11.x</td>
<td>bdf</td>
</tr>
<tr>
<td>SunOS 5.x</td>
<td>df</td>
</tr>
<tr>
<td>Solaris 7/8/9</td>
<td>df -k</td>
</tr>
</tbody>
</table>

**Note**  ADS requires at least 20-30 MB of free disk space under /tmp and var/tmp to work properly.

Checking Swap Space

The recommended minimum swap space is 300 MB. Very large designs, and designs with many hierarchical levels, could require more. To check the current amount of swap space on your system, enter one of the following:

/etc/swapinfo -t (HP)

/usr/etc/pstat -s (SunOS 5.x)

/usr/sbin/swap -s (Solaris 7/8/9)
Before You Begin

**Defining an Install Location**

Be sure you have permissions to write to the disk drive on which you want to install Advanced Design System.

- You do not need to install as root, although you may need root privileges to mount and unmount the installation CD-ROMs.
- If installed as root, all ADS files should have at least read permission for all users.

You can re-run the installation program to install components you chose not to install the first time through.

For details on install steps and options, refer to Chapter 2, Installing Advanced Design System.

**Note**   The installation program does not support cross-platform installations. Please be sure to use the correct platform-specific installation disk for your system.
Chapter 2: Installing Advanced Design System

Use the following information for installing Advanced Design System on UNIX systems. For last-minute installation information, see the file readme.htm, included on the installation disk. For last-minute program and documentation information, refer to the Release Notes document on our website at:

http://www.agilent.com/find/eesof-docs

Choose Advanced Design System 2003C > Manuals > Release Notes
Installing Advanced Design System

**Installation Overview**

1. Obtain Codewords
2. Mount installation CD
3. Run Setup program
4. Run Install program
5. Install program files
6. Add Codewords to license file and start FLEXlm
7. Will you use License Bundles?
   - Yes
     - Select License Bundle using Agilent License Preference Tool
   - No
     - Launch Advanced Design System
**Installation Steps**

Use the following steps for installing Advanced Design System on UNIX systems. If you have not done so, please review Chapter 1, Before You Begin. Also, if you installed an Early Access version of Advanced Design System 2003C, you should uninstall it before installing this release.

---

**Note** The installation program does not support cross-platform installations. Please be sure to use the correct platform-specific installation disk for your system.

---

To install Advanced Design System on UNIX systems:

1. Log onto the system using an account that has permissions to write to the disk to which you want to install.
2. Mount the Advanced Design System CD-ROM (Disk 1) making sure to use the correct CD-ROM for your platform. Mounting a CD-ROM file system on a UNIX system requires root or super-user privileges on most systems.

**Note** If you are running Solaris 7/8/9 and the Disk 1 CD-ROM has been mounted by vold, you can skip to step 3. You can check if the CD-ROM is mounted by running the mount command without any arguments.

---

The typical mount point, or directory, for a CD-ROM is /cdrom. This may be different on your system. The mount point directory must exist before you can mount the CD-ROM. To create a /cdrom directory, enter:

```
mkdir /cdrom
```

To mount the first Program CD-ROM (Disk 1), run the command for your system. Here are examples:

```
mount -rF cdfs /dev/dsk/c201d2s0 /cdrom (HP-UX 11.x)
mount -rt hsfs /dev/sr0 /cdrom (SunOS 5.x)
```

If your Solaris 7/8/9 system is not running vold, you can mount the CD-ROM using the following command:

```
mount -F hsfs -r /dev/dsk/c0t6d0s0 /cdrom (Solaris 7/8/9)
```
Installing Advanced Design System

Once the Program CD-ROM (Disk 1) is mounted, exit from being root before completing the rest of the installation procedure if you do not want to install as root.

3. Change directory to the UNIX subdirectory on the Program CD-ROM.
   
   `cd /cdrom/UNIX`

   **Note** If you are running Solaris 7/8/9, and the vold daemon is active, enter:
   
   `cd /cdrom/cdrom0/UNIX`

4. Start the installation program using the command for your system:
   
   `. /SETUP.;1' or . /SETUP* (HP-UX)
   
   `. /SETUP (SunOS 5.x, Solaris 7/8/9)

   **Note** that the Sun File Manager is not recommended to invoke SETUP.

   **Note** If you are running Netscape, or another program that uses a lot of color resources, you should shut it down before starting the Agilent EEsof Installation Manager.

5. Enter the full path to the directory where you would like Advanced Design System software to be installed. The default directory is `/usr/local/ads2003`. Choose:

   • **Enter** to install to the default destination.

   • Specify a different destination folder. If you specify a folder that does not already exist, the installation program will create it for you.

6. The installation directory you have selected is shown, along with the available disk space on the disk partition that contains this directory. If you want to keep the installation directory shown, enter y (for yes). If you want to change the installation directory, enter n (for no).
7. The Agilent EEsof Installer is loaded. Then a message displays the directory to change to and the command to enter to start the installation program. Change to the directory and enter the command to start the installation. The following is an example:

```
cd /usr/local/ads2003/install/bin
./install
```

8. The Agilent EEsof Application Installation window appears, with the Welcome tab active. This tab enables you to confirm your installation directory choice. Choose:

- **Next** to proceed.
- **Cancel** to exit the installation program.

9. The Platforms tab becomes active. Confirm or select the platform you want to install, then choose **Next**.

To install executables for more than one platform, re-run the Agilent EEsof Installation Manager program for each platform.

10. The Setup tab becomes active. This tab allows you to choose from three types of installations:

- **Typical** installs all ADS Design Suites, related modules (such as Momentum electromagnetic simulator, Digital Filter Designer, Vendor Component Libraries, etc.), examples, and documentation. The disk space required is shown on the screen.

  **Note** Typical does not install the Wireless Design Libraries such as W-CDMA, DesignGuides, nor a few specialized tools such as HDL Cosimulation.

  For a list of what is installed with a Typical Installation, click the button to the left of the Typical label and choose your installation folder to display its contents. You can also refer to “Configuring User Accounts” on page 2-14.
• **Complete** installs all Advanced Design System suites, modules, examples, and documentation. The disk space required is shown on the screen.

• **Custom** lets you choose the ADS components you want to install. For a list of Custom Installation components, refer to “Custom Installation List” on page 2-11.

**Note** While you choose here which ADS features you want to install, the ability to run them is determined by the licenses you have purchased.

Choose an installation type. The Components tab appears.

**If you chose to do a Typical or Complete installation, skip to step 15.**

11. For a Custom installation, the next screen lets you choose the components you want to install. You can always re-run the installation program to install other components. Click a component name to see a description. Select the components you wish to install and click **Next** to continue.

**Important** You must choose to install the Simulators, Schematic Capture and Layout option. You can install other options, but without Simulators, Schematic Capture and Layout, ADS will not run properly.
12. For Custom Installation only: the Options tab enables you to choose from the following custom options:

<table>
<thead>
<tr>
<th>Package</th>
<th>Description</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Manuals</td>
<td>Online manuals, help, and search engine installed to your hard disk. ADS 2003C uses HTML-based documentation displayed using your Web browser. See “Check the System Requirements” on page 1-3 for browser requirements.</td>
<td>560.3 MB</td>
</tr>
<tr>
<td>Examples</td>
<td>Complete ADS application examples</td>
<td>463.1 MB</td>
</tr>
<tr>
<td>Communications</td>
<td>Communications Systems Examples</td>
<td>42 MB</td>
</tr>
<tr>
<td>Digital Signal</td>
<td>Digital Signal Processing Examples</td>
<td>7.2 MB</td>
</tr>
<tr>
<td>Microwave Circuit</td>
<td>Microwave Circuit Examples</td>
<td>39.3 MB</td>
</tr>
<tr>
<td>Momentum</td>
<td>Momentum Examples</td>
<td>133.3 MB</td>
</tr>
<tr>
<td>RFIC</td>
<td>RFIC Examples</td>
<td>68.3 MB</td>
</tr>
<tr>
<td>RF Board</td>
<td>RF Board Examples</td>
<td>51.2 MB</td>
</tr>
<tr>
<td>Tutorial</td>
<td>Tutorial Examples</td>
<td>46.3 MB</td>
</tr>
<tr>
<td>Behavioral Models</td>
<td>Behavioral Models Examples</td>
<td>46.3 MB</td>
</tr>
<tr>
<td>Training</td>
<td>Training Examples</td>
<td>71.9 MB</td>
</tr>
</tbody>
</table>

13. The Summary tab lists the components you have selected to install. You have three options:

- **Back** to go back and make changes to your selections. You can select Back as many times as necessary to reach the screen where you want
- **Next** to keep your selections as listed and begin installing the components you have selected.
- **Cancel** to exit the Agilent EEsof Installation Manager program without installing any software.

14. The Install tab becomes active and the installation begins. Progress indicators only update after each module is installed, so do not be alarmed if it takes several minutes for the progress indicators to indicate a change.
15. If you have selected a Complete installation or a Custom installation that includes Vendor Parts Libraries and/or the Online Documentation, you will be prompted to unmount the currently inserted disk and mount installation Disk 2 when necessary.

The Information box that prompts you to insert another installation disk identifies the appropriate mount commands for your system. Type the appropriate mount command into a terminal window.

To unmount a CD-ROM:

cd /

umount /cdrom

**Note** You will need to be in the root directory to unmount the CD-ROM. If you are running Solaris 7/8/9 and vold is active, you can type the following command to unmount the CD-ROM: `eject cdrom`.

Now, mount the required CD-ROM.

16. Once you have mounted the requested installation disk, choose one of the following:

- **Apply** to continue with the installation
- **Cancel** to end the installation program
- **Reset** to reset the CD-ROM mount directory path

17. When the installation is complete, an **Installation Complete!** message appears in the **Installation Messages** portion of the Install tab.

18. When you are finished, choose **Done** to exit the Agilent EEsof Installation Manager.
19. Unmount the installation CD-ROM:

   cd /
   umount /cdrom9

Note You must be in the root directory to unmount the CD-ROM. If you are running Solaris 7/8/9 and vold is active, you can enter the following command to unmount the CD-ROM: eject cdrom.

20. Use the FLEXlm security codewords from Agilent EEsof to create a license.lic file with the correct SERVER and VENDOR line configurations. See Chapter 3, Setting Up Licenses.

21. Place the license.lic file in the licenses sub-directory of your Advanced Design System installation directory and start FLEXlm to enable your codewords. See Chapter 3, Setting Up Licenses.


   If you will be using license bundles, select a bundle using the Agilent License Preference tool. See “Using the Agilent License Preference Tool” on page 4-1.
## Typical Installation List

<table>
<thead>
<tr>
<th>Package</th>
<th>Description</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulators, Schematic Capture and Layout</td>
<td>This is the basic ADS software, including the Design Environment, Data Display, and Analog/RF Systems and Signal Processing simulators</td>
<td>309.6 MB</td>
</tr>
<tr>
<td>Design Rule Checker/Art Translators</td>
<td>Design Rule Checker verifies layouts and the artwork translators include MTOOLS (Gerber, DXF), IGES, GDSII, etc.</td>
<td>11.6 MB</td>
</tr>
<tr>
<td>Digital Filter Designer</td>
<td>Synthesizes a wide-range of FIR and IIR digital filters based on user requirements</td>
<td>4.7 MB</td>
</tr>
<tr>
<td>DSP Synthesis</td>
<td>Implements high-level DSP designs into ASICs or FPGAs</td>
<td>37.9 MB</td>
</tr>
<tr>
<td>E-Syn</td>
<td>Synthesizes lumped- and distributed- element networks for filters, matching networks, etc.</td>
<td>0.9 MB</td>
</tr>
<tr>
<td>Examples</td>
<td>Complete set of ADS application examples</td>
<td>463.1 MB</td>
</tr>
<tr>
<td>LineCalc</td>
<td>Transmission line calculator program</td>
<td>1.5 MB</td>
</tr>
<tr>
<td>Model Development Kit</td>
<td>For developing Analog/RF Systems user-defined models</td>
<td>13 MB</td>
</tr>
<tr>
<td>Momentum Planar EM Simulator</td>
<td>The Momentum planar electromagnetic simulator</td>
<td>105.4 MB</td>
</tr>
<tr>
<td>Online Documentation to Hard Disk</td>
<td>Online manuals, help, and search engine installed to your hard disk. ADS 2003C uses HTML-based documentation displayed using your Web browser, Netscape version 4.5 or higher, or Microsoft Internet Explorer version 4.0 or higher is required.</td>
<td>560.3 MB</td>
</tr>
<tr>
<td>Series IV &amp; MDS to ADS Translators</td>
<td>Translate designs from Series IV or MDS into ADS 2003C</td>
<td>12 MB</td>
</tr>
<tr>
<td>SPICE Model Generator</td>
<td>Generates SPICE models from S-parameter data</td>
<td>0.2 MB</td>
</tr>
<tr>
<td>Vendor Component Libraries</td>
<td>Parts libraries, such as the RF Transistor Library or the Analog Parts Library</td>
<td>159.9 MB</td>
</tr>
<tr>
<td>FLEXlm licensing software</td>
<td>An option included for installations with a license server on a separate machine</td>
<td>7.5 MB</td>
</tr>
</tbody>
</table>
## Custom Installation List

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulators, Schematic Capture and Layout</td>
<td>This is the basic ADS software, including the Design Environment, Data Display, Layout, and Analog/RF Systems and Signal Processing simulators</td>
<td>309.6 MB</td>
</tr>
<tr>
<td>Vendor Component Libraries</td>
<td>Parts libraries, such as the RF Transistor Library or the Analog Parts Library</td>
<td>159.9 MB</td>
</tr>
<tr>
<td>Momentum Planar EM Simulator</td>
<td>The Momentum planar electromagnetic simulator</td>
<td>105.4 MB</td>
</tr>
<tr>
<td>Design Rule Checker/Art Translators</td>
<td>Design Rule Checker verifies layouts and the artwork translators include MTOOLS (Gerber, DXF), IGES, GDSII, etc.</td>
<td>11.6 MB</td>
</tr>
<tr>
<td>Digital Filter Designer</td>
<td>Synthesizes a wide-range of FIR and IIR digital filters based on user requirements</td>
<td>4.7 MB</td>
</tr>
<tr>
<td>DSP Synthesis</td>
<td>Implements high-level DSP designs into ASICS or FPGAs</td>
<td>37.9 MB</td>
</tr>
<tr>
<td>SPICE Model Generator</td>
<td>Generates SPICE models from S-parameter data</td>
<td>0.2 MB</td>
</tr>
<tr>
<td>E-Syn</td>
<td>Synthesizes lumped- and distributed- element networks for filters, matching networks, etc.</td>
<td>0.9 MB</td>
</tr>
<tr>
<td>LineCalc</td>
<td>Transmission line calculator program</td>
<td>1.5 MB</td>
</tr>
<tr>
<td>FLEXlm licensing software</td>
<td>An option included for installations with a license server on a separate machine</td>
<td>7.5 MB</td>
</tr>
<tr>
<td>RFIC Dynamic Link</td>
<td>EDA framework integration based on inter-process communication. Facilitates ADS simulation using IC designs from the Cadence database.</td>
<td>0.3 MB</td>
</tr>
<tr>
<td>Design Kit Tool Set</td>
<td>Set of tools used to support the use of ADS Design Kits, including installation, setup, and viewing Design Kits</td>
<td>0.5 MB</td>
</tr>
<tr>
<td>cdma2000-Compliant Design Library</td>
<td>Design library of conforming behavioral models to develop CDMA communications products to TIA/IS-2000 standards</td>
<td>48 MB</td>
</tr>
<tr>
<td>TD-SCDMA Design Library</td>
<td>Design library of a low chip rate (LCR) TDD. It is one option of UTRA-TDD for mobile radio systems using 3G services of UMTS and IMT 2000.</td>
<td>2.1 MB</td>
</tr>
<tr>
<td>Digital TV Design Library</td>
<td>Design library of conforming behavioral models to develop digital TV transmitters or receivers to ISDB-T or DVB-T standards</td>
<td>49.2 MB</td>
</tr>
<tr>
<td>HDL Cosimulation</td>
<td>Used to cosimulate components represented in a hardware description language</td>
<td>0.9 MB</td>
</tr>
</tbody>
</table>
## Installing Advanced Design System

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDMA Design Library</td>
<td>Design library of conforming behavioral models to develop CDMA communications products to TIA/EIA-95 standards</td>
<td>39.3 MB</td>
</tr>
<tr>
<td>GSM Design Library</td>
<td>Design library of conforming behavioral models to develop GSM communications products</td>
<td>37.2 MB</td>
</tr>
<tr>
<td>Series IV &amp; MDS to ADS Translators</td>
<td>Translate designs from Series IV or MDS into ADS 2003C.</td>
<td>12 MB</td>
</tr>
<tr>
<td>3GPP W-CDMA Design Library</td>
<td>Design library of conforming behavioral models to develop 3rd-generation partnership project (3GPP) W-CDMA communications products</td>
<td>44.8 MB</td>
</tr>
<tr>
<td>EDGE Design Library</td>
<td>Design library of conforming behavioral models to develop enhanced data-rate for GSM evolution (EDGE) communications products</td>
<td>21.4 MB</td>
</tr>
<tr>
<td>WLAN Design Library</td>
<td>Design library of conforming behavioral models to develop products for the 5 GHz wireless LAN market</td>
<td>23.4 MB</td>
</tr>
<tr>
<td>1xEV Design Library</td>
<td>Design library of models to develop the physical layer for products based on 1xEV, which is high-speed, high-capacity wireless technology</td>
<td>26 MB</td>
</tr>
<tr>
<td>Agilent VEE Link</td>
<td>ADS link to Agilent’s VEE product</td>
<td>1 MB</td>
</tr>
<tr>
<td>ISS Cosimulation</td>
<td>Instruction Set Simulator for cosimulation with Texas Instruments DSP chips or cores</td>
<td>1.6 MB</td>
</tr>
<tr>
<td>Agilent 89600 VSA Link</td>
<td>ADS link to the 89600 Vector Signal Analyzer</td>
<td></td>
</tr>
<tr>
<td>Linearization DesignGuide</td>
<td>Tool kit to interactively explore dynamic linearization systems at the top level with templates</td>
<td>59.8 MB</td>
</tr>
<tr>
<td>Oscillator DesignGuide</td>
<td>Smart library and interactive handbook for creating useful oscillator designs and interactively characterizing their components</td>
<td>15.6 MB</td>
</tr>
<tr>
<td>Passive Circuit DesignGuide</td>
<td>Provides SmartComponents and automated assistants for the design of common passive microstrip structures</td>
<td>7 MB</td>
</tr>
<tr>
<td>Phase-Locked Loop DesignGuide</td>
<td>Interactive handbook for the creation of useful PLL designs, including templates to assist in meeting performance specifications</td>
<td>34.6 MB</td>
</tr>
<tr>
<td>Power Amplifier DesignGuide</td>
<td>Interactive tool kit that includes many simulation setups and data displays that are useful for power amplifier design</td>
<td>44.5 MB</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Size</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Bluetooth DesignGuide</td>
<td>Interactive handbook for the creation of Bluetooth communications product designs, including templates to assist in meeting performance specifications</td>
<td>38.3 MB</td>
</tr>
<tr>
<td>CDMA2000 DesignGuide</td>
<td>Interactive handbook for the creation of CDMA2000 communications product designs, including templates to assist in meeting performance specifications</td>
<td>25.1 MB</td>
</tr>
<tr>
<td>Mixer DesignGuide</td>
<td>Smart library and interactive handbook for creating useful mixer designs and interactively characterizing their components</td>
<td>27.1 MB</td>
</tr>
<tr>
<td>RF System DesignGuide</td>
<td>Interactive tool kit that includes many simulation setups and data displays that are useful for RF system design</td>
<td>71.2 MB</td>
</tr>
</tbody>
</table>
Configuring User Accounts

Configure the user accounts that will run Advanced Design System as follows:

**C Shell:**
Add the following at the end of $HOME/.cshrc:

```bash
setenv HPEESOF_DIR <install_directory>
setenv AGILEESOFD_LICENSE_FILE <path_to_license_file>
Default: $HPEESOF_DIR/licenses/license.lic
set path = ( . $HPEESOF_DIR/bin $path )
```

**Bourne or Korn Shell:**
Add the following at the end of $HOME/.profile:

```bash
HPESOSF_DIR= <install_directory>
AGILEESOFD_LICENSE_FILE= <path_to_license_file>
Default: $HPEESOF_DIR/licenses/license.lic
PATH= .:$HPEESOF_DIR/bin:$PATH
export HPEESOF_DIR AGILEESOFD_LICENSE_FILE PATH
```

**Note** If you are running Common Desktop Environment (CDE) or HP VUE, your user account may be using $HOME/.dtprofile or $HOME/.vueprofile respectively to set up your user account instead of .cshrc or .profile. The .dtprofile and .vueprofile files contain a line that can be uncommented to activate the use of .cshrc or .profile. Please see your system administrator or CDE or VUE documentation for details.

Once the user accounts are configured, each user should log in and verify that the new environment variables are set. Type the env command and check that HPEESOF_DIR and AGILEESOFD_LICENSE_FILE are set and that PATH contains a path to the Advanced Design System bin subdirectory.

If you installed Advanced Design System as root, the ownership of directories and files will be set to user id 1313 and group id 22. To change this, enter:

```bash
cd $HPEESOF_DIR
chown -R root *
chgrp -R sys *
```
Setting the Display

If you plan to run Advanced Design System from a remote computer and you want the display to appear on your local machine, you will need to set the DISPLAY environment variable:

setenv DISPLAY <my_hostname>: 0.0 (C-Shell)
DISPLAY = <my_hostname>: 0.0 (Korn Shell, Bourne Shell)
export DISPLAY

For a Sun Ray file server and diskless terminals using Solaris 8, you will need to set the DISPLAY environment variable:

setenv DISPLAY <servername>$Display (C-Shell)
set DISPLAY = <servername>$Display (Korn Shell, Bourne Shell)
export DISPLAY

For details on using the Sun Ray appliance, refer to the Sun website at:
Installing Advanced Design System

Installing to Multiple Disk Partitions or Directories

If you do not have a single partition large enough to hold the entire Advanced Design System installation, you can spread the installation across partitions using symbolic or soft links. The symbolic links are created before installation to redirect files to other partitions.

For example, suppose you want to install Advanced Design System with most of the software installed in /opt/apps/eesof, but you want the example projects to be installed to /disk2 due to lack of disk space in the /opt partition. Before starting the Agilent EEsof Installation Manager, you would do the following:

1. Create the main installation directory:
   ```
   cd /opt/apps
   mkdir eesof
   ```
2. Create the directory that will hold the example files on /disk2:
   ```
   cd /disk2
   mkdir ads_examples
   ```
3. Create a link named examples in the main installation directory that points to the /disk2/ads_examples directory:
   ```
   cd /opt/apps/eesof
   ln -s /disk2/ads_examples examples
   ```
4. Begin the installation process. When the examples are installed, the example projects will follow the /opt/apps/eesof/examples link to /disk2/ads_examples.

---

2-16 Installing to Multiple Disk Partitions or Directories
Following is a list of the larger directory (not the complete list) names for Advanced Design System, along with approximate sizes. Any of these directories can be re-directed to another disk partition as shown above for the examples directory. The sizes shown are for a complete installation.

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Approximate Size (in Megabytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ComponentLibs</td>
<td>158 MB</td>
</tr>
<tr>
<td>bin</td>
<td>157 MB</td>
</tr>
<tr>
<td>circuit</td>
<td>33 MB</td>
</tr>
<tr>
<td>de</td>
<td>27 MB</td>
</tr>
<tr>
<td>doc</td>
<td>200-560 MB (depending on Design Libraries)</td>
</tr>
<tr>
<td>examples</td>
<td>463 MB (if all examples are installed)</td>
</tr>
<tr>
<td>DesignGuides</td>
<td>378 MB</td>
</tr>
<tr>
<td>hptolemy</td>
<td>59 MB</td>
</tr>
<tr>
<td>modelbuilder</td>
<td>13 MB</td>
</tr>
</tbody>
</table>
Using Multiple ADS Versions

Use the following instructions to maintain and run more than one version of ADS (such as version 2003A and 2003C). Keep a separate $HOME directory for each version of Advanced Design System to help in structuring all the files and prevent problems that may arise if the configuration files are shared between multiple installations. The $HOME directory is where all your projects are kept.

Setting the HOME Environment Variable

You need to specify the variable $HOME separately for each version of ADS that you want to run. You can set up two directories from which you can run different scripts to launch the version of ADS you want.

Below are example scripts. Please change them to match your system.

Script for ADS 2003A

```
#!/bin/ksh
#
# Script for starting ADS 2003A on UNIX systems.
cd /users/jdoe/ads2003a
HOME=/users/jdoe/ads2003a
HPEESOF_DIR=/utils/eesof/ads2003a
PATH=$HPEESOF_DIR/bin:$PATH
export HOME HPEESOF_DIR PATH
ads
```

Script for ADS 2003C

```
#!/bin/ksh
#
# Script for starting ADS 2003C on UNIX systems.
cd /users/jdoe/ads2003c
HOME=/users/jdoe/ads2003c
HPEESOF_DIR=/utils/eesof/ads2003c
PATH=$HPEESOF_DIR/bin:$PATH
export HOME HPEESOF_DIR PATH
ads
```
Installing Connection Manager

If you will be using the Connection Manager product, you should be aware that it contains two parts: the Connection Manager client, and the Connection Manager server.

The Connection Manager client is installed during the ADS installation. To run it, you must obtain the license link_connect_mgr. Then, to use Connection Manager to communicate with instruments, you must install the Connection Manager server.

The Connection Manager server must be installed on a Windows PC. The server software is located on CD-ROMs labelled for installation on Windows PC systems. When you install the Connection Manager server, you must also install ADS which supports the server functions. These installations of ADS and the Connection Manager server do not require licenses. For details about installing ADS and the Connection Manager server on a PC, see Installing Connection Manager in the chapter Installing Advanced Design System located in the Installation on PC Systems manual. For general information about Connection Manager, see the Connection Manager documentation.

---

**Note**  The Connection Manager client and server software must be from the same release. If you used an older release of Connection Manager, then you install ADS 2003C on a client system, you must also install ADS 2003C and its Connection Manager server onto the Windows PC you will use as the server system.
Installing Advanced Design System
Chapter 3: Setting Up Licenses

Use the following information to set up licenses for Advanced Design System on UNIX systems. After you install Advanced Design System using the steps described in Chapter 2, Installing Advanced Design System, you will need to set up the FLEXlm license manager and your ADS license file (license.lic) before you can run Advanced Design System.

Advanced Design System uses Macrovision Corporation’s Flexible License Manager (FLEXlm) software for all software security configurations. When you run the Advanced Design System Setup program, the FLEXlm software is installed at \(<installation\ folder>/licenses/bin\) where \(<installation\ folder>\) is the destination folder you specified when you ran Setup.

**Important** For HP-UX 11.x systems from Agilent, avoid keying licenses to the LAN ID/MAC address. Macrovision FLEXlm does not recommend using an ethernet address for the hostid on HP-UX 11.x systems.

For details on using FLEXlm, refer to the Macrovision website at:

http://www.macrovision.com/

Choose FLEXlm
Installing Licenses

You must request and install new license codewords for ADS 2003C. To learn how to request codewords, see “Get Codewords for ADS 2003C” on page 1-6. To install and configure your new license file, complete the steps in the following sections.

1. Save License File
2. Edit License File
3. Place License File
4. Start License Server
5. Provide Access to Licenses
6. Will you use License Bundles?
   - Yes: Select License Bundle using Agilent License Preference Tool
   - No: Launch Advanced Design System

**Note** If you are using the Mentor Graphics IFF interface for Advanced Design System, you need to install Mentor codewords in a separate procedure. Obtain information from your Mentor Graphics representative.
Save the License File

When you receive your codeword file from Agilent EEsof Business Support, it will be called license.lic. Save the license.lic file using the same file name. Most codewords are distributed by e-mail.

Edit the License File

Edit your license.lic file to correct the SERVER line and add information to the VENDOR line. Refer to “SERVER Line Guidelines” on page 3-7 and “VENDOR Line Guidelines” on page 3-8 for details. You can use the Agilent License Information Tool to check your environment variable settings, display your license.lic file, and show your license and server status. For details, refer to “Using the Agilent License Information Tool” on page 3-37.

Note  Each line in the license.lic file must be a single continuous line with each field separated by a single space. You may line wrap lines using the backslash (\') character, but be very careful not to add a space after the backslash. Otherwise, you can remove the backslash and make each INCREMENT line one continuous line.
Setting Up Licenses

**Node-Locked File**

The codeword file must follow the format shown in the following example. This example is from a node-locked file where the quantity, displayed on the first line after the date, is typically “1”:

```
SERVER unknown 80fb214d
VENDOR agileesofd
INCREMENT ads_datadisplay agileesofd 2.3 01-jun-2003 1 \
   VENDOR_STRING="80fb214d : JRDNSO IWSPGBB ICHLEDL JIWDLWB \ 
   ICUNETS MCTENRX YGRTAKP SOG" HOSTID=00008645603e SIGN="008C 0B3B \ 
   B6CE F5FD A202 41E9 4976 A13E 8FD7 74EC B500 077B 6A8B 43D7 \ 
   6ACC 2844 FC22 ED6F B9C5 0702 BD2C"
INCREMENT ads_layout agileesofd 2.3 01-jun-2003 1 \
   VENDOR_STRING="80fb214d : JRDNSO IWSPGBB ICHLEDL JIWDLWB \ 
   ICUNETS MCTENRX YGRTAKP SOG" HOSTID=00008645603e SIGN="03D6 7CB8 \ 
   1839 1C88 FADD 2B28 C262 BFE5 2829 F6B6 6300 85FE E3F6 2606 \ 
   127A AC3E 3500 B5DE DF02 1B13 C474"
INCREMENT ads_schematic agileesofd 2.3 01-jun-2003 1 \
   VENDOR_STRING="80fb214d : JRDNSO IWSPGBB ICHLEDL JIWDLWB \ 
   ICUNETS MCTENRX YGRTAKP SOG" HOSTID=00008645603e SIGN="0220 C506 \ 
   FC49 2049 A306 30FC 8D30 3679 FB9F 902A A001 BD12 AF37 5D9F \ 
   C2C2 AC85 1FC7 4DE6 D4DD DBD4 7011"
INCREMENT sim_harmonic agileesofd 2.3 01-jun-2003 1 \
   VENDOR_STRING="80fb214d : JRDNSO IWSPGBB ICHLEDL JIWDLWB \ 
   ICUNETS MCTENRX YGRTAKP SOG" HOSTID=00008645603e SIGN="03B4 86F8 \ 
   F981 C8F5 50DB A4CA 8EDB F6C4 83BA 5D01 3102 B3E5 CC10 EABB \ 
   A03A 87F3 C441 9B55 25E5 2EFF 3C69"
INCREMENT sim_linear agileesofd 2.3 01-jun-2003 1 \
   VENDOR_STRING="80fb214d : JRDNSO IWSPGBB ICHLEDL JIWDLWB \ 
   ICUNETS MCTENRX YGRTAKP SOG" HOSTID=00008645603e SIGN="016E 2104 \ 
   6CF7 325D F69D EDE2 86CF 5737 5729 6389 C702 61B3 BESC 7841 \ 
   F4E1 8C24 4FF6 36AE A0CC 9B55 5C7D"
```
Floating-License File

The codeword file for a floating license is the same as the previous node-locked file example, with two exceptions: There is no HOSTID identifier in a floating license and the quantity can be any number, one or more, depending upon the number of licenses you own. Below is a sample of a section of a floating-license file:

SERVER unknown 80fb214d
VENDOR agileesofd
INCREMENT ads_datadisplay agileesofd 2.3 01-jun-2003 2 \ 
  VENDOR_STRING="80fb214d : JRDNMSO IWSGGBB ICHLEDL JIWDLWB \ 
  ICUNETX MCTENRX YGRTAKP SOG" SIGN="02FC 0DC8 DA50 6376 E488 F950 \ 
  35AF 8DC4 2838 C461 8003 2B99 3A53 B533 DA68 2DA8 A7AF 7464 \ 
  C6E4 6F0E 4C8B"
INCREMENT ads_layout agileesofd 2.3 01-jun-2003 2 \ 
  VENDOR_STRING="80fb214d : JRDNMSO IWSGGBB ICHLEDL JIWDLWB \ 
  ICUNETX MCTENRX YGRTAKP SOG" SIGN="006A 8EAA 8FE3 3EC6 B329 CC25 \ 
  421C 41E9 084F 0F74 AF00 E13D A9AB 43D9 F831 1F19 ED3F 3156 \ 
  3F7F 306D 3BE9"
INCREMENT ads_schematic agileesofd 2.3 01-jun-2003 2 \ 
  VENDOR_STRING="80fb214d : JRDNMSO IWSGGBB ICHLEDL JIWDLWB \ 
  ICUNETX MCTENRX YGRTAKP SOG" SIGN="027E B964 CEE5 C2C2 FF44 7413 \ 
  6556 0117 F84A 3770 B702 FB20 31C7 D2B2 79B4 8549 7990 0BAF \ 
  A653 9479 5FDE"
INCREMENT sim_harmonic agileesofd 2.3 01-jun-2003 2 \ 
  VENDOR_STRING="80fb214d : JRDNMSO IWSGGBB ICHLEDL JIWDLWB \ 
  ICUNETX MCTENRX YGRTAKP SOG" SIGN="03AF 98EC 7DEB BB1A C193 7453 \ 
  E058 7149 0170 9EB8 6703 D1A2 20CA E144 763A 8495 1711 0DD4 \ 
  1C59 0DC3 DDA1"
INCREMENT sim_linear agileesofd 2.3 01-jun-2003 2 \ 
  VENDOR_STRING="80fb214d : JRDNMSO IWSGGBB ICHLEDL JIWDLWB \ 
  ICUNETX MCTENRX YGRTAKP SOG" SIGN="0316 C5A9 E9B0 F397 1273 5ED1 \ 
  D439 7BA7 70C1 D03D CA02 8C8C A830 4C4A 7615 CC9B 51E7 CAEC \ 
  8152 5999 98E1"
Setting Up Licenses

**SERVER Line Format**

The SERVER line, by default, has the following format:

```
SERVER hostname hostid
```

where

- `hostname` is the network name of the machine whose hostid appears in field 3 of the SERVER line.
- `hostid` is the unique machine id of the license server machine.

### Operating System Command

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP-UX</td>
<td>/usr/bin/hostname</td>
</tr>
<tr>
<td>Sun</td>
<td>/bin/hostname</td>
</tr>
</tbody>
</table>

Optionally, a TCP port number may be specified on this line, for example:

```
SERVER hostname hostid tcp_port_number
```

tcp_port_number is the TCP port number that the license server will listen at for license requests. An example port number is 27000.
SERVER Line Guidelines

- Your license file should contain an odd number of SERVER lines; for example, 1 or 3. If you have 3 SERVER lines, the first SERVER is the primary license server and the other two are backup servers. All three SERVER lines must use the same tcp_port_number.

- You may only change the hostname and the optional tcp_port_number fields.

- Adding or removing SERVER lines requires a new license file.

- By default, Agilent EEsof sets hostname to unknown. The SERVER line does not contain a port address. FLEXlm software assigns a port address in the range of 27000 to 27009. The examples in this manual use a port address of 27000, but your license file may differ. If you do not want to use the port address assigned by FLEXlm, specify any other unused port number for your network.

  Note Enter a specific port address on the SERVER line for improved license check-out performance. You may enter a port address outside the range of 27000 to 27009, as long as the address is not used elsewhere. Also, set the environment variable AGILEESOFD_LICENSE_FILE as described in "Place License File" on page 3-11.

- If the hostid is wrong, or changes for some reason, you will need to request a new license file from Agilent EEsof.

Here are examples of properly configured SERVER lines:

SERVER joshua 2072EFE45 (default - FLEXlm assigns port address)
SERVER isaiiah 20472A3D3 27000 (optional - port address is specified)
Setting Up Licenses

VENDOR Line Format

The VENDOR line, by default, has the following format:

VENDOR daemon_name

where

daemon_name is the name of the vendor daemon.

Optionally, you may specify a path to the vendor daemon and a path to the FLEXlm options file, for example:

VENDOR agileesofd /my_install_dir/licenses/vendors/agileesofd /my_install_dir/licenses/agileesofd.opt

VENDOR Line Guidelines

• During installation of Advanced Design System, the vendor daemon is installed in the $HPEESOF_DIR/licenses/vendors and $HPEESOF_DIR/licenses/bin directories.

• The daemon name must be agileesofd.

• The path to the options file is intentionally left blank. If you want to use FLEXlm options, you must add a full path to your option file. To learn about FLEXlm options, refer to the section “Using FLEXlm Options” on page 3-20. If the file does not exist and this option is not blank, a warning message will appear in the flex.log file.

• Here is an example of a properly configured VENDOR line (without an options file):

VENDOR agileesofd /my_install_dir/licenses/vendors/agileesofd
INCREMENT Line Format

The INCREMENT lines must have the following format:

INCREMENT feature vendord ver exp num vendorstring hostid sign

where

feature is the name of the feature licensed by this line.
vendord is the name of the vendor daemon that will manage this feature.
ver is the version of the feature licensed by this line.
exp is the expiration date of this license.
num is the number of licenses this line enables.
vendorstring is the CPU ID of the primary license server.
hostid is an optional field. If this field exists, it is the hostid of the machine that this license is node-locked to. Only the machine whose hostid appears in this field may checkout this license.
sign is the encrypted codeword.
Setting Up Licenses

INCREMENT Line Guidelines

- None of the fields on the INCREMENT lines are editable. Any change made to any of the fields on an INCREMENT line will make that feature invalid. The only valid edit of an INCREMENT line is to add a backslash (\) to line wrap the line. Be careful not to add an extra space between fields when using a backslash to line wrap an INCREMENT line.

- Here are two examples of valid INCREMENT lines.

  Floating license example:
  
  INCREMENT ads_layout agileesofd 2.3 01-jun-2003 2 \
  VENDOR_STRING="80fb214d : JRDNMSO IWSPGBB ICHLEDL \ 
  ICUNETS MCTENRX YGRTAKP JIWDLWB SOG" SIGN="006A 8EAA 8FE3 \ 
  3EC6 B329 CC25 421C 41E9 084F 0F74 AF00 E13D A9AB \ 
  43D9 F831 1F19 ED3F 3156 3F7F 306D 3BE9"

  Node-locked license example:
  
  INCREMENT ads_schematic agileesofd 2.3 01-jun-2003 1 \
  VENDOR_STRING="80fb214d : JRDNMSO IWSPGBB ICHLEDL \ 
  ICUNETS MCTENRX YGRTAKP JIWDLWB SOG" HOSTID=00008645603e \ 
  SIGN="0220 C506 FC49 2049 A306 30FC 8D30 3679 FB9F 902A A001 \ 
  BD12 AF37 5D9F C2C2 AC85 1FC7 4DE6 D4D0 DBD4 7011"

The backslash used to line wrap these two INCREMENT line examples is prefaced by a space and contains a carriage return immediately after it. The \ character is the absolute last character of the line it is on.
Place License File

A copy of the license.lic file must be placed on all SERVER machine(s) listed in the license.lic file.

License Placement Guidelines

• The recommended location for the license.lic file is:
  
  $HPEESOF_DIR/licenses/license.lic

• You might need root permission to copy the license.lic file into the Advanced Design System installation directory if Advanced Design System was installed by a user logged in as root.

• You can choose to locate the license.lic file someplace else on the SERVER machine(s). If you choose to do this, make sure that Advanced Design System users properly set AGILEESOFD_LICENSE_FILE.

• Make sure that the license.lic file has at least read permission for all users:

  cd $HPEESOF_DIR/licenses
  chmod 555 license.lic

  This command gives you read/executable permissions only.

• Place a copy of the $HPEESOF_DIR/license directory on all SERVER machines or custom install the FLEXlm license server on each machine.
Setting Up Licenses

**Start the License Server (lmgrd)**

Use the following procedure and guidelines to start the license server, lmgrd, on the SERVER machine.

---

**Important**  Be sure to use the following guidelines to update all existing license servers with the latest version of the FLEXlm software (e.g., lmgrd and lmutil). The software is installed with ADS 2003C. Using older versions may cause license-encryption errors, invalid hostid results, and unsupported feature errors.

Verify that all multiple and redundant servers are updated including any license administration scripts in use. Run lmutil directly from the ADS 2003C installation location ($HPEESOF_DIR/licenses/bin) for information to help modify the scripts.

You will need to stop, then restart, the license server to make these updates.

---

3-12   Installing Licenses
Guidelines for Starting lmgrd

- You only need to run lmgrd on the SERVER machine(s).
- If the SERVER machine(s) has Advanced Design System installed on it, you will find the FLEXlm license manager daemon (lmgrd) in the
  $HPEESOF_DIR/licenses/bin directory. If the SERVER machine does not have
  Advanced Design System installed, you can copy the $HPEESOF_DIR/licenses
directory from the machine that has Advanced Design System installed.
- Advanced Design System installs version 8.2a of FLEXlm. Make sure you use
  the version 8.2a lmgrd and agileesofd supplied or a newer version of lmgrd. You
  can determine the version of lmgrd and agileesofd by typing the following
  commands:

  cd $HPEESOF_DIR/licenses/bin
  ./lmgrd -v
  cd $HPEESOF_DIR/licenses/vendors
  ./agileesofd -v

Note  HP-UX users must set the permissions on /dev/lan0 to read, write and
execute for all users before attempting to start lmgrd. You must have root
permissions to do this: chmod 777 /dev/lan0
Setting Up Licenses

**To start lmgrd:**

Change the directory to where lmgrd resides on the SERVER machine and execute lmgrd. For example:

```
cd $HPEESOF_DIR/licenses/bin
./lmgrd -c ../license.lic > ../flex.log
```

The login executing lmgrd must have full permissions to the licenses/bin directory and at least write permissions to the directory specified for flex.log.

All error, warning and status messages will be redirected to the flex.log file. After starting lmgrd, wait approximately 30 seconds, then look at the contents of flex.log to see if there are any errors that need to be corrected.

**To verify that the licenses are available:**

Make sure that the flex.log file does not contain any errors, then run lmstat as follows:

```
cd $HPEESOF_DIR/licenses/bin
./lmutil lmstat -a -c ../license.lic | more
```

Or, you may launch the Agilent License Information Tool to do this. Refer to “Using the Agilent License Information Tool” on page 3-37 for more information.

If the licenses are available, you should see a listing similar to the following:

```
lmutil - Copyright (C) 1989-2002 Globetrotter Software, Inc.
Flexible License Manager status on Tue 2/20/03 07:39
License server status: 27000@joshua
  License files on joshua: /ads2003/licenses/bin/../license.lic:
    joshua: license server UP (MASTER) v8.2
Vendor daemon status (on joshua):
   agileesofd: UP v8.2
Feature usage info:
Users of Circuit_convolution: (Total of 3 licenses available)
Users of Circuit_envelope: (Total of 3 licenses available)
Users of Circuit_harmonic: (Total of 3 licenses available)
Users of Circuit_linear: (Total of 3 licenses available)
Users of Circuit_nwa: (Total of 3 licenses available)
Users of Circuit_transient: (Total of 3 licenses available)
Users of Layout: (Total of 3 licenses available)
Users of Microwave_lib: (Total of 3 licenses available)
Users of Schematic: (Total of 3 licenses available)
```
Provide Access to Licenses

Before attempting to start Advanced Design System, you must configure each user’s login environment to allow access to the licenses on the SERVER machine(s). To do this you need to configure the environment variable named AGILEESOFD_LICENSE_FILE in the user’s .profile or .cshrc.

---

**Note**  The AGILEESOFD_LICENSE_FILE environment variable will override any LM_LICENSE_FILE settings you might have set up. If AGILEESOFD_LICENSE_FILE is not set, LM_LICENSE_FILE will be used.

---

For example:

**C Shell:**

```
setenv AGILEESOFD_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic
```

**Bourne/Korn Shell:**

```
AGILEESOFD_LICENSE_FILE=$HPEESOF_DIR/licenses/license.lic
export AGILEESOFD_LICENSE_FILE
```

You can avoid the need to have a copy of the license.lic file directly on the machine running Advanced Design System by setting AGILEESOFD_LICENSE_FILE as follows:

```
AGILEESOFD_LICENSE_FILE=<port>@<SERVER_hostname>
```

where

- **port** is the TCP port number from the SERVER line(s) of the license.lic file.
- **SERVER_hostname** is the network name of a SERVER machine serving Advanced Design System licenses. This must be a name that the SERVER is known by on the network. You should be able to successfully ping this name from the machine that will run Advanced Design System.
Setting Up Licenses

Or, if your license server is set up to search for an available port, your AGILEESOFD_LICENSE_FILE should read:

```
AGILEESOFD_LICENSE_FILE=@<SERVER_hostname>
```

For example,

**C Shell:**

```
setenv AGILEESOFD_LICENSE_FILE 27000@joshua
```

Or

```
setenv AGILEESOFD_LICENSE_FILE @joshua
```

**Bourne/Korn Shell:**

```
AGILEESOFD_LICENSE_FILE=27000@joshua
export AGILEESOFD_LICENSE_FILE
```

Or

```
AGILEESOFD_LICENSE_FILE=@joshua
export AGILEESOFD_LICENSE_FILE
```

The syntax to access multiple license servers is as follows.

**C Shell:**

```
setenv AGILEESOFD_LICENSE_FILE 27000@server1:27000@server2:27000@server3
```

**Bourne/Korn Shell:**

```
export AGILEESOFD_LICENSE_FILE=27000@server1:27000@server2:27000@server3
```

However, in this case, “server” should be replaced by the actual license server name or IP address, and the “27000” may need to be changed to the actual port number on the license server. Note that the list of servers is separated by colons (:). For details on running FLEXlm-licensed products from multiple vendors refer to “Merging Multiple Vendor Licenses” on page 3-23.
Using a UNIX-to-PC Floating License

A Windows PC system can access the UNIX license server's licenses.lic file in either of two ways:

- By copying the licenses.lic file from the UNIX license server to the Windows PC's $HPEESOF_DIR/licenses folder.
- By setting the AGILEESOFD_LICENSE_FILE variable on the Windows PC to point to the UNIX license server as follows:

  ```
  set AGILEESOFD_LICENSE_FILE=\<port>\@\<host>
  ```

  For example:

  ```
  set AGILEESOFD_LICENSE_FILE=27000@joshua
  ```

  where
  
  - 27000 is the port number on the SERVER line in the licenses.lic file on the UNIX license server.
  - joshua is the hostname of the UNIX license server.

Conversely, the license server can be a Windows PC with a floating license locked to a LAN card or dongle hardware key and the UNIX computer can be set to point to it in the same way by using its host name or IP address.

Automating FLEXlm License Manager Startup

You can automate the FLEXlm startup so that lmgrd is started automatically each time the license server machine is rebooted by adding the following three lines for a startup routine to the appropriate rc file for your operating system:

```bash
/ads/licenses/bin/lmgrd -c /ads/licenses/license.lic > /ads/licenses/flex.log &
echo "Starting Agilent EEsof FLEXlm license daemon......"
/usr/bin/sleep 5
```

**Note** Be sure to change all references to /ads to the actual path of your Agilent EEsof software installation directory.

Following are separate instructions for the supported operating systems.
Setting Up Licenses

**HP-UX Operating Systems**

2. Create a file in this directory named `Sagileesofd`.

   **Note**  The S is capitalized. All other letters are in lower-case.

3. Place the FLEXlm startup routine (shown above) into this file.
4. Set the permissions for this file as follows:
   
   ```
   chmod 755 Sagileesofd
   chown root Sagileesofd
   chgrp sys Sagileesofd
   ```

**Solaris Operating Systems**

1. Change to the `/etc/rc3.d` directory.
2. Create a file in this directory called `Sagileesofd`.

   **Note**  The S is capitalized. All other letters are in lower-case.

3. Place the FLEXlm startup routine (shown above) into this file.
4. Set the permissions for this file as follows:
   
   ```
   chmod 755 Sagileesofd
   chown root Sagileesofd
   chgrp sys Sagileesofd
   ```

3-18  Installing Licenses
Selecting a License Bundle

This step is necessary only if you are using license bundles.

If you have been using license packages in previous versions, you should be aware that packages were replaced by license bundles beginning with ADS 2003A. You must select a bundle using the Agilent License Preference Tool when starting ADS to ensure a license bundle is being used. Bundles are an improvement over packages by giving you more control over which license bundles are used during an ADS session. To learn how to select bundles using the preference tool, see “Using the Agilent License Preference Tool” on page 4-1.
Special Licensing Needs

Use the following information to accommodate any special licensing needs you may have. For details on using FLEXlm, refer to the Macrovision website at:

http://www.macrovision.com/

Choose FLEXlm

Using FLEXlm Options

An options file enables the license administrator to control the security parameters of FLEXlm. Specifically the license administrator can:

• Allow the use of features based on user, hostname or display name.
• Deny the user of features based on user, hostname or display name.
• Reserve licenses based on user, hostname or display name.
• Control the amount of information logged about license usage.

Creating an Options File

Use the desired options listed below to create the options file using any text editor. Ideally, you should keep the options file in the same directory as your license.lic file. Also, add the pathname to the options file in the license.lic file as the fourth field on the VENDOR line for agileesofd as shown in the following example. (Remember to use the backslash (\) character if the file contains wrapped lines.)

```
VENDOR agileesofd /ads2003C/licenses/vendors/agileesofd \
/ads2003C/licenses/agileesofd.opt
```

You can include comments in your options file by starting each comment with a pound sign “#”. Everything in the options file is case-sensitive. Be sure that user names and feature names, for example, are entered correctly. The available options are:

• EXCLUDE
  Deny a user access to a feature.

• EXCLUDEALL
  Deny a user access to all feature served by this vendor daemon.

• GROUP
  Define a group of users for use with any options.
• **INCLUDE**
  Allow a user to use a feature.

• **INCLUDEALL**
  Allow a user to use all features served by this vendor daemon.

• **NOLOG**
  Turn off logging certain items.

• **REPORTLOG**
  Specify that a logfile be written suitable for use by the FLEXadmin End-User Administration Tool.

• **RESERVE**
  Reserve licenses for an individual user or groups of users.

• **TIMEOUT**
  Works only for specified simulator and library licenses.

• **TIMEOUTALL**
  Works for all simulator and library licenses.

Use the following steps to create and use an options file. Details about each step located in “Installing Licenses” on page 3-2:

1. Create an options file with your required options.

2. Modify your license.lic file so that the VENDOR or DAEMON line points to this option file as shown in this example:

   ```
   VENDOR agileesofd /ads2003C/licenses/vendors/agileesofd \
   /ads2003C/licenses/agileesofd.opt
   ```

3. Start up your license server (lmgrd) that is pointing to your license file. You must stop it first if it is running. It’s important that a message is displayed or recorded in the FLEXlm log verifying the license manager is using the options file. The following example shows that the license manager is using the agileesofd.opt file containing the TIMEOUTALL option set to 900 seconds:

   ```
   17:35:14 (agileesofd) Using options file: "/ads2003C/licenses/agileesofd.opt"
   17:35:15 (agileesofd) ALL FEATURES: INACTIVITY TIMEOUT set to 900 seconds
   ```

4. Set **AGILEESOFD_LICENSE_FILE** to point to your license server.

5. Run ADS.
Specifying the TIMEOUT Option

You can set a custom time-out period for simulator and library licenses using the TIMEOUT or TIMEOUTALL options. If you do not specify a time-out value in your options file or do not have an options file, a default two-hour limit is used. These time-out options apply to those application features that have explicitly implemented time-out via the heartbeat function. This includes licenses for the Analog/RF and Signal Processor simulators and for libraries, and do not affect licenses for the design environment and data display. The time-out option sets the amount of time a feature may remain idle before its license is released and reclaimed by the vendor daemon. The TIMEOUT option enables you to identify specific licenses, and the TIMEOUTALL affects all licenses (simulators and libraries).

To use TIMEOUT, add an entry for each feature to the options file using the following format:

```
TIMEOUT feature_name seconds
```

where:

- **feature_name** is name of the feature.
- **seconds** is the number of seconds before inactive license is reclaimed. The minimum value is 900 seconds (15 minutes). If you specify a time-out value smaller than the minimum, the minimum is used.

The option TIMEOUTALL works just like TIMEOUT, but applies to all features.

```
TIMEOUTALL seconds
```

Here are example entries you can include in your options file:

- **To set a time-out for the harmonic balance simulator to one hour (3600 seconds):**
  ```
  TIMEOUT sim_harmonic 3600
  ```

- **To set time-outs for multiple simulators to different periods:**
  ```
  TIMEOUT sim_linear 900
  TIMEOUT sim_harmonic 3600
  ```

- **To set a time-out for all simulators and libraries to one hour (3600 seconds):**
  ```
  TIMEOUTALL 3600
  ```
Updating the License File

If you have been running FLEXlm and receive updated codewords from Agilent EEsof, you can add the new licenses to the FLEXlm environment as follows:

1. Replace the existing license files on the license servers and clients with the new license files.
2. On the primary server, run `lmutil lmreread`. This causes the lmgrd on the primary server to re-read the license file and update all of the other lmgrd processes on the network.
3. After you have done this, you can run `lmutil lmstat -a` to verify that the license servers have received the new license information.

If this does not work, you may need to stop all of the lmgrd processes on your network and then restart them as described in the section “Installing Licenses” on page 3-2.

Merging Multiple Vendor Licenses

When you are running FLEXlm-licensed products from multiple vendors, you have three ways to prevent licensing conflicts during installation:

- Multiple license server nodes; each running one lmgrd and one license file
- One license server node running one lmgrd and one license file
- One license server node running multiple lmgrds and multiple license files

Each lmgrd can only read a single license file. With the first option you will have more license servers to monitor. With the third option you have only one server but multiple lmgrds to administer.

Your product’s license file(s) define the license server(s) by hostname and hostid in the SERVER line(s) in the license file.

- If the license files for two or more products contain identical hostids on the SERVER line(s), then these files can be combined.
- If the license files for two products contain different hostids on a SERVER line, then the license servers for those products will be running on different nodes and the license files cannot be combined.
Setting Up Licenses

If you have two or more products whose license servers run on the same node (as specified by the SERVER lines in the license files), you may be able to combine the license files into a single license file.

- If the SERVER lines in those files have identical hostids, then you can combine the files into a single file.
- If the SERVER lines have different hostids, then you must keep the license files separate.

More precisely, you can combine two license files under the following conditions:

1. The number of SERVER lines in each file is the same.
2. The hostid field of each SERVER line in one file exactly matches the hostid field of each SERVER line in the other file.

Some possible reasons license files may not be compatible are:

- License files are set up to run on different server nodes, so hostids are different.
- One file is set up for single server (has only one SERVER line), the other is set up for redundant servers (has multiple SERVER lines).
- One vendor uses a custom hostid algorithm, so the hostids on the SERVER lines are different even though the files are for the same machine.

If your license files are compatible as described above, then you can combine license files and run a single lmgrd, as described in “Combining License Files from Multiple Vendors” on page 3-25. If the license files are not compatible, then you must keep the license files separate and run separate copies of lmgrd for each license file, as described in the section, “Using Separate License Files on the Same Server Node” on page 3-26.

**Important** There is virtually no performance or system-load penalty for running separate lmgrd processes.
Combining License Files from Multiple Vendors

If your license files are compatible, you can combine them using any text editor. To combine license files, merge all of the compatible license files into one file, then edit out the extra SERVER lines so that only one set of SERVER lines remains. Write out this data, and you have your combined license file.

If you combine license files from multiple vendors, it is a good idea to keep a copy of the combined license file in each vendor's default license file location. This way, your users can avoid having to set AGILEESOFD_LICENSE_FILE, because each package finds its license information in the default place. On UNIX, you can do this with a symbolic link from each default location to the location of the combined license file.

FLEXlm Version Component Compatibility

When you combine license files for two different FLEXlm-licensed products, the products may not use the same version of FLEXlm. FLEXlm is designed to handle this situation. There are two basic compatibility rules for FLEXlm:

1. A newer lmgrd can be used with an older vendor daemon, but a newer vendor daemon might not work properly with an older lmgrd.

2. A newer vendor daemon (or lmgrd) can be used with an older client program, but a newer client program might not work properly with an older vendor daemon.

From these two compatibility rules come the simple rules for selecting which version of administration tools to use:

1. Always use the newest version of lmgrd and the newest version of each vendor daemon.

2. Use the newest FLEXlm utilities.

For specific application programs, you can use either the new or the old version (with the assumption that the vendor daemon for that application is at least as new as the application).
Setting Up Licenses

Using Separate License Files on the Same Server Node

You must run a separate copy of lmgrd for each license file. When you run multiple copies of lmgrd, there are two details to remember:

1. The port number on the SERVER line of each license file must be unique. You can use a standard text editor to change the port number in each license file so that they are all different.

2. You must make sure that you are using a compatible version of lmgrd when you start it up for a particular license file. This can be done by using an explicit path to lmgrd.

When running client programs (such as a licensed application), you can set the AGILEESOFD_LICENSE_FILE environment variable to point to multiple license files. For example, you may have a license file from vendor ABC and a license file from vendor XYZ with incompatible servers. You can place the license file from vendor ABC into:

/user/flexlm/abc.lic

and the license file from vendor XYZ into:

/user/flexlm/xyz.lic

then set the AGILEESOFD_LICENSE_FILE environment variable to point to both of them. The syntax is as follows:

AGILEESOFD_LICENSE_FILE=27000@server1;27000@server2;27000@server3

Note that each path is separated with a semi-colon.

AGILEESOFD_LICENSE_FILE can point to only one license file for FLEXlm v1.x applications.
Redundant License Servers

You can set up a redundant or backup license server(s), in case a primary server is unavailable. If your license.lic file has the maximum number of SERVER lines (three), you have a redundant license server configuration. The license setup is identical to a single SERVER configuration, with the exception that no licenses will be available until a majority of the license servers are running. That is, if you have three SERVER lines, at least two must be up and running before any licenses will be available for checkout. Be sure that the FLEXlm software is loaded and running on each server.

**Note** If you have more than one SERVER line in the license.lic file, you must start lmgrd on all the SERVER machines to enable the licenses.

Controlling License Path Settings

The lmutil utility provides the lmpath function which allows direct control over FLEXlm license path settings. You can use lmpath to add to, override, or get the current license path set in the registry. This enables you to change or view path settings without locating individual settings in the Windows registry on the PC or in the FLEXlm registry (.flexlmrc) on UNIX.

The lmutil utility is located in $HPEESOF_DIR/licenses/bin. This location must be in your PATH, or use the following command before running the utility:

```
cd $HPEESOF_DIR/licenses/bin
```

The usage for this function is:

```
    lmutil lmpath {status | -add | -override} {vendor_name | all} license_path_list
```

where

- `status` displays the current license path settings.
- `add` appends `license_path_list` to the front of the current license-path settings or creates the list of license-path settings, if it doesn’t exist, initializing it to `license_path_list`. Duplicates are discarded.
- `override` overrides the existing list of license-path settings with the contents of `license_path_list`. If `license_path_list` is the null string, “”, the specified list is deleted. For example:
Setting Up Licenses

```bash
lmutil lp -override agileesofd ""
Deletes the value of AGILEESOFD_LICENSE_FILE from the registry.

lmutil lp -override vendor2 ""
Deletes the value of VENDOR2_LICENSE_FILE from the registry.

lmutil lp -override all ""
Deletes the value of LM_LICENSE_FILE from the registry.
```

*vendor* is a string naming a particular vendor daemon name. Affects the value of vendor\_LICENSE\_FILE. For example, use `agileesofd` to affect AGILEESOFD\_LICENSE\_FILE.

*all* refers to all vendor daemons. Affects the value of only LM\_LICENSE\_FILE.

*license_path_list* is the new path setting(s). On UNIX, this is a colon-separated list, and on Windows it is a semi-colon-separated list. If license\_path\_list is the null string, "", then the list is deleted for the specified vendor. Though you can enter specific license file names, you gain flexibility by entering only a path without a file name. This will include all *.lic files in the same location.

---

**Note**  Environment variable settings (set in your shell) always override these registry settings.

---
Checking the Status

Before you change license path settings, Agilent recommends that you display the current settings. To display the settings, enter the following commands:

```
Imsutil lmpath -status
```

The following example status listing is from UNIX and is similar to PC listings:

```
lmpath - Copyright (C) 1989-2002 Globetrotter Software, Inc.
Known Vendors:

agileesofd: /ads2003a/licenses/license.lic:/ads2003c/licenses/license.lic

Other Vendors:

/usr/local/flexlm/licenses/license.lic
```

**Note**  Where a path is set to a directory, each of the *.lic files are listed separately.
Setting Up Licenses

Changing License Path Settings

When adding or overriding path settings, lmpath sets the FLEXlm entry in the Windows registry on the PC, or changes the file $HOME/.flexlmrc on UNIX. Here are examples of how license settings may appear in each registry:

UNIX:

```
AGILEESOFD_LICENSE_FILE = /ads2003a/licenses:/ads2003c/licenses
```

Windows:

```
Registry location:
My Computer\HKEY_LOCAL_MACHINE\Software\Agilent\ADS2003C

Registry license path setting:
AGILEESOFD_LICENSE_FILE REG_SZ C:\ADS2003C\licenses
```

To change license path settings, enter the appropriate command in a Command Prompt on Windows, or a terminal window on UNIX. You can adapt the following examples which change path settings for AGILEESOFD_LICENSE_FILE:

- To add path settings on UNIX:
  `lmutil lmpath -add agileesofd <new_lic_path1>:<new_lic_path2>`

- To add path settings on Windows:
  `lmutil lmpath -add agileesofd C:\<new_lic_path1>;C:\<new_lic_path2>`

- To replace the current path settings on UNIX:
  `lmutil lmpath -override agileesofd <new_lic_path>`

- To replace the current path settings on Windows:
  `lmutil lmpath -override agileesofd C:\<new_lic_path>`

3-30 Special Licensing Needs
Managing Multiple ADS Versions

This section discusses how to manage the licenses for multiple versions of ADS.

Backward Compatibility of Codewords

The following table lists previous ADS versions with details of their license management. The compatibility of codewords with the various ADS versions is discussed below.

<table>
<thead>
<tr>
<th>Release Name</th>
<th>License File Version</th>
<th>Daemon Name</th>
<th>FLEXlm Version</th>
<th>License Environment Variable</th>
<th>Default License File Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADS 1.5</td>
<td>1.5</td>
<td>hpeesofd</td>
<td>7.0g</td>
<td>LM_LICENSE_FILE</td>
<td>$HPEESOF_DIR/licenses/license.dat</td>
</tr>
<tr>
<td>ADS 2001</td>
<td>1.7</td>
<td></td>
<td></td>
<td>HPEESOFD_LICENSE_FILE</td>
<td>$HPEESOF_DIR/licenses/license.dat</td>
</tr>
<tr>
<td>ADS 2002</td>
<td>1.9</td>
<td>agileesof</td>
<td>7.2h CRO</td>
<td>AGILEESOF_LICENSE_FILE</td>
<td>$HPEESOF_DIR/licenses/</td>
</tr>
<tr>
<td>ADS 2002C</td>
<td>2.1</td>
<td></td>
<td></td>
<td></td>
<td>$HPEESOF_DIR/licenses/</td>
</tr>
<tr>
<td>ADS 2003A</td>
<td>2.3</td>
<td>agileesofd</td>
<td>8.2a CRO</td>
<td>AGILEESOFD_LICENSE_FILE</td>
<td>$HPEESOF_DIR/licenses/</td>
</tr>
<tr>
<td>ADS 2003C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

ADS 2003C and 2003A Codewords

- ADS 2003C codewords will also work with ADS 2003A as long as the codeword is not a new codeword that has been introduced in ADS 2003C.
- ADS 2003A codewords will also work with ADS 2003C as long as support for the codeword has not been removed in ADS 2003C.
- ADS 2003C and 2003A codewords will not work with any previous versions of ADS and codewords from previous versions of ADS will not work with ADS 2003C or 2003A.
Setting Up Licenses

**ADS 2002C and 2002 Codewords**

- ADS 2002C codewords will also work with ADS 2002 as long as the codeword is not a new codeword that has been introduced in ADS 2002C.
- ADS 2002 codewords will also work with ADS 2002C as long as support for the codeword has not been removed in ADS 2002C.
- ADS 2002C and 2002 codewords will not work with any other versions of ADS and codewords from other versions of ADS will not work with ADS 2002C or 2002.

**Combining ADS 2003C Codewords with Other Agilent EEsof EDA Codewords**

For ADS 2003C, the vendor daemon agileesofd is used. This is the same vendor daemon that was used for ADS 2003A. If you want to serve ADS 2003C licenses and earlier from the same server, you need to have the latest version of lmgrd, v8.2a, and two or three DAEMON lines in your license file, depending on how many versions you want to support. The ADS daemon names available are:

- agileesofd - for ADS 2003A and 2003C
- agileesof - for ADS 2002 and 2002C
- hpeesofd - up to and including ADS 2001

For example, the license file would include:

```
SERVER hpnmems 77a588a7 1700

VENDOR agileesofd /ads2003C/licenses/vendors/agileesofd
VENDOR agileesof /ads2002C/licenses/vendors/agileesof
DAEMON hpeesofd /ads2001/licenses/vendors/hpeesofd
```

You would then add the INCREMENT lines for the different products to the file.

Here is how you might build a license file that contains ADS 2003C, ADS 2003A, ADS 2002C, ADS 2001, and IC-CAP 2001 codewords. The name and extension of the license file are arbitrary (i.e., license.dat, license.lic or adslicenses.txt). By default, all ADS versions up to and including ADS 2001 look for a file named license.dat and all ADS versions from ADS 2002 to ADS 2003C look for a file named license.lic. You can
use one of these names, or some other name you prefer. Whatever name you choose to use, make sure you set the environment variables to point to your license file.

Supported environment variables are:

- **AGILEESOFD_LICENSE_FILE** for ADS 2003A and 2003C
- **AGILEESOF_LICENSE_FILE** for ADS 2002 and 2002C
- **HPEESOFD_LICENSE_FILE** for ADS 2001
- **LM_LICENSE_FILE** for ADS 1.5 and earlier

For example, if the combined codeword file is named adslicenses.txt, then:

- ADS 2003A and 2003C will use:
  \[AGILEESOFD_LICENSE_FILE=/licenses/adslicenses.txt\]
- ADS 2002 and 2002C will use:
  \[AGILEESOF_LICENSE_FILE=/licenses/adslicenses.txt\]
- ADS 2001 will use:
  \[HPEESOFD_LICENSE_FILE=/licenses/adslicenses.txt\]
- ADS 1.5 and earlier will use:
  \[LM_LICENSE_FILE=/licenses/adslicenses.txt\]

Each version of ADS uses a certain search order to look for the environment variable:

- ADS 2003A and 2003C will first look for the environment variable named **AGILEESOFD_LICENSE_FILE**. If **AGILEESOFD_LICENSE_FILE** and **LM_LICENSE_FILE** are both defined, ADS 2003A and 2003C will use **AGILEESOFD_LICENSE_FILE** and ignore **LM_LICENSE_FILE**. If **AGILEESOFD_LICENSE_FILE** is not defined, then ADS 2003A and 2003C will default to **LM_LICENSE_FILE**.
- ADS 2002 and 2002C will first look for the environment variable named **AGILEESOF_LICENSE_FILE**. If **AGILEESOF_LICENSE_FILE** and **LM_LICENSE_FILE** are both defined, ADS 2002 and 2002C will use **AGILEESOF_LICENSE_FILE** and ignore **LM_LICENSE_FILE**. If **AGILEESOF_LICENSE_FILE** is not defined, then ADS 2002 and 2002C will default to **LM_LICENSE_FILE**.
- ADS 2001 will first look for the environment variable named **HPEESOFD_LICENSE_FILE**. If **HPEESOFD_LICENSE_FILE** and
Setting Up Licenses

LM_LICENSE_FILE are both defined, ADS 2001 will use HPEESOFD_LICENSE_FILE and ignore LM_LICENSE_FILE. If HPEESOFD_LICENSE_FILE is not defined, then ADS 2001 will default to LM_LICENSE_FILE.

- All previous ADS versions, up to and including ADS 1.5 will use LM_LICENSE_FILE.

Even though all versions of ADS will default to LM_LICENSE_FILE if that is the only environment variable that exists, it is recommended that you use the supported environment variables listed above.

Example of a Merged License File

SERVER solarone 80FB214D 1700
DAEMON hpeesofd /hfs/d1/local/licenses/hpeesofd
VENDOR agileesof /hfs/d1/local/licenses/agileesof
VENDOR agileesofd /hfs/d1/local/licenses/agileesofd
#
# ADS 2001 codewords
#
INCREMENT Adapt_comp hpeesofd 1.5 03-nov-2002 5 EC7A98E3FB4AC8771142 \ VENDOR_STRING=s=80FB214D
INCREMENT Ad_da_appkit hpeesofd 1.5 03-nov-2002 5 \ 1CCA189368AF358196C4 VENDOR_STRING=s=80FB214D
INCREMENT Ampsa_appkit hpeesofd 1.5 03-nov-2002 5 \ 0CBAB813D8101E34EB55 VENDOR_STRING=s=80FB214D
INCREMENT Analog_lib hpeesofd 1.5 03-nov-2002 5 9CEA88930822C5CF81AC \ VENDOR_STRING=s=80FB214D
INCREMENT Tx_appkit hpeesofd 1.5 03-nov-2002 5 6C0A5873869F624DF5 \ VENDOR_STRING=s=80FB214D
INCREMENT User_defined_model hpeesofd 1.5 03-nov-2002 5 \ 2CAA8E326E3D9DD8888B VENDOR_STRING=s=80FB214D
INCREMENT Verilog_code_gen hpeesofd 1.5 03-nov-2002 5 \ FCAA489350CD3768D44 VENDOR_STRING=s=80FB214D
INCREMENT Vhdl_code_gen hpeesofd 1.5 03-nov-2002 5 \ FC4A58B306109B640C5C VENDOR_STRING=s=80FB214D
INCREMENT Wcdma3g_des_lib hpeesofd 1.5 03-nov-2002 5 \ DC7AA8938909E4861BF VENDOR_STRING=s=80FB214D
INCREMENT Wcdma_des_lib hpeesofd 1.5 03-nov-2002 5 \ 7C0A38F308FA2C30CE3D VENDOR_STRING=s=80FB214D
INCREMENT Wlan_des_lib hpeesofd 1.5 03-nov-2002 5 \ 4C8A6893E5596C86399 VENDOR_STRING=s=80FB214D
#
# IC-CAP 2001 codewords
#

3-34 Managing Multiple ADS Versions
INCREMENT a_si_tft agileesof 6.0 29-oct-2001 1 D0A4535DE290 \ 
  VENDOR_STRING=s=80FB214D
INCREMENT ac_driver agileesof 6.0 29-oct-2001 1 1A9EE36873A0 \ 
  VENDOR_STRING=s=80FB214D
INCREMENT analysis agileesof 6.0 29-oct-2001 1 025C2B939BD5 \ 
  VENDOR_STRING=s=80FB214D
INCREMENT curtice_statz_fet agileesof 6.0 29-oct-2001 1 7D88F11FEE4B \ 
  VENDOR_STRING=s=80FB214D
INCREMENT dc_driver agileesof 6.0 29-oct-2001 1 65C14D4C7948 \ 
  VENDOR_STRING=s=80FB214D
INCREMENT gummel_poon_bjt agileesof 6.0 29-oct-2001 1 8FB9632C0555 \ 
  VENDOR_STRING=s=80FB214D
INCREMENT ucb_bsim3 agileesof 6.0 29-oct-2001 1 BEDFA8C2810F \ 
  VENDOR_STRING=s=80FB214D
INCREMENT ucb_bsim4 agileesof 6.0 29-oct-2001 1 D454A8AB830D \ 
  VENDOR_STRING=s=80FB214D
INCREMENT ucb_mos2_mos3 agileesof 6.0 29-oct-2001 1 D9768F388827 \ 
  VENDOR_STRING=s=80FB214D
INCREMENT vbic_bjt agileesof 6.0 29-oct-2001 1 3DE6FB45CD8C \ 
  VENDOR_STRING=s=80FB214D

#= ADS 2002C Codewords
#
INCREMENT ads_datadisplay agileesof 2.0 30-jun-2002 1 \ 
  VENDOR_STRING=80FB214D HOSTID=80fb214d SIGN="008E 5A70 FECF \ 
  8BEF 9B3A 8A67 7375 0A51 0940 A264 6B00 C335 666B 03E2 D8E7 \ 
  99A8 A0F9 9007 2AC4 EF7D E101"
INCREMENT ads_datadisplay agileesof 2.0 30-jun-2002 1 \ 
  VENDOR_STRING=80FB214D SIGN="01CB 4272 B241 5A67 A4C8 CADB \ 
  A080 FFB2 7796 6C29 ECO2 C3A9 FDBA BE47 COC0 F027 5552 947F \ 
  64CC 06BA 2201"
INCREMENT ads_drc agileesof 2.0 30-jun-2002 1 VENDOR_STRING=80FB214D \ 
  HOSTID=80fb214d SIGN="0138 3E48 7191 3703 8FBF 2614 067B 2A7E \ 
  203F 4F0C C900 79FE F186 9B1E 2B10 3B3D D650 2204 18CF 00C9 \ 
  3E3A"
INCREMENT trans_veriloggen agileesof 2.0 30-jun-2002 1 \ 
  VENDOR_STRING=80FB214D HOSTID=80fb214d SIGN="014D A119 4C16 \ 
  9831 16B3 B5C6 EFE7 ED11 D0AE F389 EA00 590B 0E0A E0CD 5E4D \ 
  9C66 E6AD B27E 2CC4 8C1A 1D9D"
INCREMENT trans_veriloggen agileesof 2.0 30-jun-2002 1 \ 
  VENDOR_STRING=80FB214D SIGN="0332 DEBA 839B B80F D2A0 0237 \ 
  BF97 0C7E 1CF3 CB15 2902 A5CB 47FA ECCB 9C6B BED2 E39D F8EB \ 
  EF84 FADE 7AC8"
INCREMENT trans_vhdlgen agileesof 2.0 30-jun-2002 1 \ 
  VENDOR_STRING=80FB214D HOSTID=80fb214d SIGN="03D0 0C40 7E3C \ 
  E656 FA8A ADF2 B161 97C1 CE6C DC0C DA00 A704 91C9 F5A0 30C6 \ 
  DA2A 60C0 A435 E003 02A0 C7A4"
Setting Up Licenses

INCREMENT trans_vhdlgen agileesof 2.0 30-jun-2002 1 \
  VENDOR_STRING=80FB214D SIGN="028D FD25 DOE4 AD1A AOB7 5D61 \ 
    E2A8 7CC2 8135 D605 8200 F200 39D8 E5AF 4B9E D240 3682 4BAA \ 
    D9BD 6FB3 E580"
#
#ADS2003C codewords
#
INCREMENT ads_datadisplay agileesofd 2.3 07-jul-2003 1 \
  VENDOR_STRING="00047518D858 : O2GAZUD WSGSONJ 2HNECZL 12WKCKE \ 
    LRXYGSO MWYFKGP AKBPONX LOYSO" HOSTID=00047518d858 SIGN="0246 \ 
    771A BBA2 A0D4 B29E 7371 6FF7 F3D9 161A 1204 EE00 2E92 8AC0 \ 
    1AF7 FAF9 5B2C B017 23F7 91E8 BF97 B9AD"
INCREMENT ads_drc agileesofd 2.3 07-jul-2003 1 \
  VENDOR_STRING="00047518D858 : QEGHABO KEYWTHV 1HEIWND JFAVQ2A \ 
    UJXJZEW KYARWEOQ GY" HOSTID=00047518d858 SIGN="02EC 9EA3 EE62 \ 
    BDBC 9793 019D 0551 FD3E 20DD D0C1 D301 DA95 9F79 16A8 5E11 \ 
    1B81 E7CC 90F8 68A0 E116 8F0B"
INCREMENT ads_encoder agileesofd 2.3 07-jul-2003 1 \
  VENDOR_STRING="00047518D858 : GONJAZX FHGGNAP BNOGIAH PBKWEYK \ 
    UCKGULU YS02GAZ UDWSGS" HOSTID=00047518d858 SIGN="02B7 178E \ 
    2893 8446 A5C4 0990 830E CC2C F215 528B 6401 9B93 9540 A54C \ 
    B85A A68E 0049 200F 1685 96D1 FD7F"
INCREMENT ads_layout agileesofd 2.3 07-jul-2003 1 \
  VENDOR_STRING="00047518D858 : BUYPSCY ESZGY2G PVZBPON XODFINY \ 
    IUIUACJ EFQGAYX XLYSX" HOSTID=00047518d858 SIGN="032E E2FE \ 
    1D41 5386 F290 C7A3 207B 20C6 9187 D2D5 0D00 7DB9 8FF8 531A \ 
    9947 9A9D 5D72 A8E6 9807 3037 F7EA"
Using the Agilent License Information Tool

The Agilent License Information Tool is available to check your environment variable settings, display your licenselic file, and show your license and server status.

To run this tool from the ADS Main window, choose Tools > License Information.

To run it from the terminal window, type the following line

```
$HPEESOF_DIR/bin/aglmtool
```

and press Enter to display the following window:
Setting Up Licenses
Chapter 4: Using Advanced Design System

To get you started using Advanced Design System on a UNIX system, this section includes some basics along with useful tips for resolving problems that might occur after you have installed Advanced Design System.

Running Advanced Design System

Environment variables must be set before you can run ADS. To set the environment variables, see “Configuring User Accounts” on page 2-14.

Your FLEXlm license file must be properly configured and installed before you can run Advanced Design System. To set up your license file, follow the instructions in Chapter 3, Setting Up Licenses.

To run Advanced Design System, open a terminal window and enter the command:

```bash
ads
```

Choose Help > Topics and Index > Quick Start for help on getting started with Advanced Design System.

Using the Agilent License Preference Tool

Note This section applies only to customers who have purchased license bundles. License bundles replaced license packages in ADS 2003A. License bundles are either Pay-Per-Use License (PL) bundles, or Limited Term Package (LTP) bundles. Typically, only PL or LTP bundles are available on a system - not both. You must select a license bundle when starting ADS, and the License Preference Tool is a convenient way to make a selection.

If you have been using license packages in previous versions, you should be aware that packages were replaced by license bundles beginning with ADS 2003A. A bundle looks like any other INCREMENT line in the licenseslic file, but ADS recognizes the feature name as a collection, or bundle, of individual features. When ADS checks out the license bundle, it enables all the functionality associated with the individual features. You must select a license bundle using the Agilent License Preference Tool prior to running ADS. This sets the environment variable AGILEESOFD_LICPREF_<hostname>. Since you cannot check out more than one
Using Advanced Design System

bundle, you have more control over which license bundles are used during an ADS session.

**Note** You only need to run the License Preference Tool when you want to change the latest bundle selection.

---

**Running the License Preference Tool**

To run the License Preference Tool:

- **UNIX** There are two ways to start the License Preference Tool. In a terminal window:
  - When starting ADS, enter `ads -p`. This runs the License Preference Tool, then runs ADS after you finish choosing bundles.
  - To run the tool as a standalone utility, enter `$HPEESOF_DIR/bin/aglmpref`. This runs only the License Preference Tool.

- **Windows** There are two ways to start the License Preference Tool:
  - From your Start menu, choose Programs > Advanced Design System 2003C > ADS Tools > License Preference Tool.
  - Modify the Advanced Design System shortcut located on the Start menu. Right-click the Advanced Design System icon, and choose Properties. Edit the shortcut command on the Target line to include the `-p` option as shown in this example:
    ```
    C:\ADS2003C\bin\ads.exe -p
    ```
    This runs the License Preference Tool every time you start ADS.
The License Preference window appears similar to the figures below (Figure 4-1 and Figure 4-2). It enables you to view the available bundles and their features, and select bundles.

- To see the features available in a bundle, click the expansion icon next to the bundle name under Available License Bundles.

- To select a bundle, choose one of the bundles listed under Available License Bundles, then click Add. The selected bundle appears under Selected License Bundles.

- To accept your choice, click OK. This sets the environment variable AGILEEESOFD_LICPREF_<hostname> in:
  
  **UNIX:** $HOME/.flexlmrc

  **Windows Registry:** HKEY_CURRENT_USER\SOFTWARE\FLEXlm License Manager

---

**Note**  You must have write permissions to update these areas.
Figure 4-1. License Preference Tool with ltp_analog Selected
Running Advanced Design System 4-5

Figure 4-2. License Preference Tool Showing ltp_analog Features

How the License Preference Tool Works

• When you run the License Preference Tool, it attempts to locate a license file using the following license definitions:
  • Environment variable AGILEESOFD_LICENSE_FILE
  • $HPEESOF_DIR/licenses/license.lic
  • aglmtool -c <port_address>@<hostname> (example port address is 27000)

• The License Preference Tool will show all possible bundles if a license file is not located.

• You can select a bundle according to specific rules controlled by the License Preference Tool. See “Bundle-Selection Rules” on page 4-6.

• ADS will start when a license bundle is selected, and ADS will not use a bundle unless it is selected using the License Preference Tool.
Using Advanced Design System

• If, while using ADS, the feature you attempt to use is not in the currently selected bundle, ADS will attempt to check out a valid floating or nodelocked license for the feature. This is known as license roll-over. If license roll-over fails to check out a license, a license error will appear even if another bundle with the requested feature is available.

You can then select another bundle that contains the feature. Save your work, and exit ADS. Then run the License Preference Tool to remove and add bundles, and restart ADS.

Bundle-Selection Rules

The License Preference Tool controls bundle selection using the following rules. A warning message appears for any incorrect selection.

If you are using Limited Term Package Bundles

• LTP bundles (except ltp_design_guides) contain a design environment codeword (ads_schematic) enabling ADS to run. You must select an LTP bundle containing a design environment codeword for a license preference to occur.

• Only one LTP bundle containing a design environment codeword can be selected at a time.

• The ltp_design_guides bundle (if available) can be selected with any other LTP bundle except ltp_iccap.

• Any PL bundles available on your system cannot be selected with an LTP bundle.

• If ADS and RF Design Environment are installed on the same UNIX system, RFDE bundles cannot be selected with LTP bundles.

If you are using Pay-Per-Use License Bundles

• The pl_desenv and pl_ui bundles contain a design environment codeword (ads_schematic) enabling ADS to run. You must select either pl_desenv or pl_ui for a license preference to take place. Other PL bundles appearing under pl_desenv are not selectable.

• Any LTP bundles available on your system cannot be selected with PL bundles.

• After selecting a PL bundle, you cannot select any additional bundles except for the following conditions:
• The pl_design_guides bundle (if available) can be selected with the PL bundle.

• If ADS and RF Design Environment are installed on the same UNIX system, only the pl_rfde bundle (if available) can be selected for RFDE.

Starting ADS in Verbose Mode (Debug Mode)

ADS 2003C can be started in verbose (debug) mode to display more information about what is occurring as ADS runs. This extra information can be very useful to debug a problem with ADS both at startup and in general operation. In verbose mode, ADS writes log files that can be used by Agilent EEsof EDA Technical Support to help track down any problems.

To start ADS in verbose mode, do the following:

1. Open a terminal window.
2. Type ads_verbose.

This will start ADS. You will see some messages indicating the location of two log files. Note the location of these files as indicated in the messages. The file names are as follows:

ads_daemon.log
ads_verbose.log

Note: If ads_verbose is not found, you may need to set the HPEESOF_DIR and PATH environment variables.

Run ADS until the problem you are trying to debug occurs, then take a look at the ads_daemon.log and ads_verbose.log files for errors.

If you can't locate the trouble based on the contents of the log files, please contact Agilent EEsof EDA Technical Support. You will want to e-mail the log files to the support engineer working with you.
If ADS Does Not Start

It is possible to install programs or options for which you have not purchased licenses. Although the icons and features will appear in the software, you cannot access the applications without a license. Contact your Agilent EEsof sales representative to obtain additional licenses.

If your Advanced Design System applications will not start:

- Make sure all of your licensing requirements are correctly set up, as explained in Chapter 3, Setting Up Licenses.

- Using a text editor, open and review the install.log file in your installation directory to see if there are any apparent problems with the installation structure. (You can re-run Setup if necessary to re-install.)

- Try using the Agilent License Information Tool, which is available to check your environment variable settings, display your license.lic file, and show your license and server status. Refer to “Using the Agilent License Information Tool” on page 3-37 in Chapter 3, Setting Up Licenses.

If you cannot find the problem, run ADS in verbose (debug) mode and contact Technical Support to help pinpoint the problem. See “Starting ADS in Verbose Mode (Debug Mode)” on page 4-7.
Common Licensing Problems

Following are solutions to common problems that occur regarding the FLEXlm licensing setup for Advanced Design System.

For details on using FLEXlm and lmtools, refer to the Macrovision website at:

http://www.macrovision.com/

Choose FLEXlm

Where to Begin

If you are having trouble getting FLEXlm working, the best place to begin troubleshooting is the flex.log file. The flex.log file is typically located in $HPEESOF_DIR/ licenses.

Read the flex.log file and look for error or warning messages.

If nothing shows up in the flex.log file, try setting the following environment variable, then start Advanced Design System:

C Shell (/bin/csh)

    setenv HPEESOF_DEBUG_MODE key

Bourne/Korn Shell (/bin/sh, /bin/ksh)

    HPEESOF_DEBUG_MODE=key
    export HPEESOF_DEBUG_MODE

Look for errors or warnings in the shell where you started Advanced Design System.
Common Errors and Solutions

Following are possible solutions to certain license-related error messages that occur.

**ADS Does Not Run After Starting the License Server**

If the following error message appears when you run ADS, additional license configuration may be needed:

```
No such feature exists
Feature: ads_schematic
License path: $HPEESOF_DIR/licenses/license.lic;$HPEESOF_DIR/licenses/licenses.dat
FLEXlm error: -5,357
```

This error can appear if your license.lic file contains license bundles and you have not run the License Preference Tool to select a license bundle. You must select a license bundle using the License Preference Tool, so ADS will know to use it.

**Inconsistent Encryption Code**

This error occurs when the information on the INCREMENT lines in the license.lic file is corrupted. Check the license.lic file for the following:

1. Make sure that each line of the license.lic file is a single continuous line with each field separated by a single space.

2. If there are backslash characters (\”) line wrapping the lines, make sure that the backslash character is the absolute last character on its line. Even a space after the “\” will cause a problem.

3. Try removing the backslash characters and joining the INCREMENT lines, so that each INCREMENT line is a single continuous line with no line wrap.

4. If the license.lic file was transferred from DOS to UNIX, make sure to remove the control M’s (^M) at the end of all the lines in the license.lic file. If spaces are added to the end of each line to eliminate the ^M’s, the spaces must also be removed. The spaces turn out to be just as disruptive as the ^M’s. The best way to remove the ^M’s is using the vi editor and the following substitution command:

   ```
   :1,$ s/.*/g
   ```

5. Make sure that none of the original SERVER line hostid information has been changed. Make sure that none of the SERVER lines have been eliminated.
Invalid Host or Unable to Determine Machine ID

This can be caused by one of the following:

1. Make sure that the information on the SERVER line(s) in license.lic is correct.

2. If the licenses are node-locked, and you attempt to run Advanced Design System on a machine other than the machine the licenses are node-locked to, you will get a license error indicating invalid host. To check if this is the case, look at the $HPEESOF_DIR/licenses/license.lic file and check the INCREMENT lines. If each INCREMENT line ends in a machine hostid, then the licenses are node-locked to the machine whose id is shown. You can, however, export the display from the node-locked machine to another display.

3. If you are on an HP workstation, check the permissions of the /dev/lan0 file. This file must have read and write permissions for all:

   chmod 777 /dev/lan0

   The FLEXlm lmgrd and agileosf vendor daemons use this file and must be able to read and write to this device.
Invalid System Clock Time

FLEXlm detects when systems have had their dates set more than 24 hours back, and prevents users from using expired licenses by setting the clock back. It works by looking for any files in “/” or “/etc” that have a date more than 24 hours in the future.

Use the command `ls -lat` in “/” and “/etc” to find the offending file(s). The date of the offending file(s) can be corrected by using the touch command:

```
touch <filename>
```

If the file is a link, the link must be removed and then recreated. If the link itself is dated ok, check the date of the actual file or directory it points to. The pointed to file must also have a valid date.

A Feature is Not Enabled

FLEXlm codewords have both enable and expiration dates. If the codeword enable date is in the future with respect to the current machine date, then this error will occur.

First check the date on the computer. If it is not today's date, correct it. On UNIX systems, the date can be set using the date command:

```
date mmddhhmm[yy]
```

For example, to set the date to 23 Sept, 2003 at 13:30, the command would be:

```
date 0923133003
```

If this still does not correct the problem, or if the date is correct, then request new codewords with an enable date set to today's date.
Cannot Connect to License Server

If you see a flex.log file with the following errors:

(lmgrd) Started agileesofd
(agileesofd) Vendor daemon can’t talk to lmgrd (cannot connect to license server) port 27000
(lmgrd) Vendor daemon died with status 241
(lmgrd) Since this is an unknown status, lmgrd will attempt to re-start the vendor daemon.
(lmgrd) REStarted agileesofd (internet tcp_port xxxx)

Make sure that the lmgrd and agileesofd daemon are the correct version (current version is 8.2a). The lmgrd daemon should have the same or higher version number as agileesofd. You can check version numbers as follows:

```
cd $HPEESOF_DIR/licenses
./bin/lmgrd -v
./vendors/agileesofd -v
```

Make sure that the workstation is connected to a network or that the network connector on the workstation is properly terminated. FLEXlm will not work if the network connection is down or if the network services are not starting properly. Check all physical network connections to make sure that they are okay and look for errors during machine boot up. On HP 700 workstations, look at the /etc/rc.log file for errors.

Make sure that the agileesofd is being started successfully by lmgrd. If agileesofd cannot be started from the path specified on the VENDOR line in the license.lic file, this error will occur. Also make sure that the agileesofd file has execute permissions:

```
cd $HPEESOF_DIR/licenses/vendors
chmod 755 agileesofd
```
Address Already in Use

The tcp port number specified on the SERVER line in the license.lic file is in use by another process. Try the following: Kill any stranded lmgrd processes. Remove the /usr/tmp/.flexlm/lmgrd.xxxx file that contains the tcp port you want to use. You can remove the entire /usr/tmp/.flexlm directory if you are the only one using lmgrd on this machine, then restart lmgrd. If you still have a problem, try using a different tcp port number on the SERVER line in license.lic and then restart lmgrd.

Here is an example of properly configured SERVER lines:

```
SERVER joshua 2072EFE45 27000
SERVER isaiah 20472A3D3 27000
SERVER jonah 2052C6416 27000
```
Printing and Plotting

Advanced Design System uses Xprinter for all Postscript, HPGL2 and PCL printing. For a complete list of output devices supported with Xprinter, consult the HTML file called Supported_Printers_XPV331.html, in <installation directory>/xprinter. This file lists the supported printers and also has a link to the Bristol website for the latest printer drivers. Your printer manufacturer’s website is also a good source for the latest printer driver software.

Printing From UNIX

Printing and plotting from Advanced Design System is accomplished by establishing the desired print setup and then choosing File > Print. For a complete description of Advanced Design System printing, refer to Chapter 16, “Printing and Plotting” in the Advanced Design System Schematic Capture and Layout. The following information assumes you have already set up and configured your system for printing.

Adding a Printer

Use the following steps to add a printer. You will need to define a port and then associate a printer with that port. You will need read and write permissions for your $HOME/.XprinterDefaults file.

To define a port and add a printer:
1. Choose File > Print Setup to open the Print Setup dialog box.

2. Click Install to open the Printer Installation dialog box with a list of all currently installed printers.
3. Click Add Printer to open the Add Printer dialog box that lists all available printer devices and all currently defined ports.

![Add Printer dialog box](image)

If the printer you want to use doesn't have a driver listed, use one of the following options:

- Select the closest match in the list based on the class/type of printer.

- Download a driver from the manufacturer's website. If the website doesn't have a UNIX driver listed, try the PC (Windows) driver. After you download the .ppd file, save it to the $HPEESOF_DIR/xprinter/ppd directory as a .ps (PostScript) file, that is, with a .ps extension.

- Select the generic postscript printer option from the Printer Devices list and then select a port definition.
4. Click **Define New Port** to display the Ports dialog box with a list of all currently defined ports.

5. Add the port(s) you want to access for printing:
   - On HP 700 and Sun Solaris workstations, click **Spooler** and the list of ports is automatically generated (based on your printcap file).
   - On all other workstations, type the port definition in the Edit Port field using the following syntax: `printer name=print command`, where `print command` is the print alias, just as you would type it in the terminal window. Click **Add-Replace**. Repeat for each desired port.

   **Note** Port names can be any names you choose with the exception of `FILE:` which is a reserved port name.

6. Click **Dismiss** to accept the new port definitions and return to the Add Printer dialog box with its updated Current Port Definitions list.
7. Select the desired printer from the list of Printer Devices.
8. Select the port you want to associate with this printer.

9. Click Add Selected to update the Currently Installed Printers list in the Printer Installation dialog box.

10. Dismiss the Add Printer and Printer Installation dialog boxes. You will now be able to select any of the installed printers, as needed.
Agilent EEsof Technical Support

Agilent EEsof worldwide technical support is available Monday through Friday. The toll-free North America hotline is open 6:00 am to 5:00 pm PT. Throughout Europe, the localized Online Technical Support Centers are open during business hours, typically 8:30 am to 5:30 pm, local time; throughout Asia, the localized Customer Response Centers are open during business hours, typically 9:00 am to 6:00 pm, local time.

The e-mail addresses for the various regions are listed below. However, for both the regional e-mail addresses and local telephone numbers for more than 25 countries, please refer to the Agilent EEsof Web site at

   http://www.agilent.com/find/eesof-supportcontact

North America
   Phone: 1 800 47 EEsof (473-3763) · Fax: 707-577-3511
   e-mail: eesof_support@agilent.com

Europe: e-mail: eesof-europe_support@agilent.com
Japan: e-mail: edasupport@pn.agilent.com
Korea: e-mail: eesof_korea@agilent.com
Asia: e-mail: eesof-asia_support@agilent.com
Chapter 5: Using Remote Simulation

Use the following information to enable and run remote Advanced Design System simulations using a UNIX client. Before starting the client process, you must first set up a server (host) computer on which to run remote simulations.

In this chapter, the term server has the same meaning as host or remote computer, and the term client has the same meaning as local computer.

Note These procedures are not exactly the same for the Momentum Electromagnetic simulator. For Momentum remote simulation, refer to “Performing Remote Simulations” in the Momentum documentation.

Remote simulation with a UNIX client works among the following system pairs:
- UNIX to UNIX
- UNIX to Windows NT/2000/XP
- UNIX to Linux

Note ADS is supported on Linux only for remote simulation. See “Using Remote Simulation on Linux” on page 5-2.

Note The LSF type of remote simulation is described in “Using LSF Remote Simulation” on page 5-12. Momentum does not support LSF remote simulation.
Using Remote Simulation on Linux

Advanced Design System is supported on Linux only for remote simulation, where the Linux system is the simulation server. Generally, information about setting up and running remote simulations on UNIX simulation servers also applies to Linux systems. Use this section for information about Linux requirements and installation that is different from the information provided for UNIX systems. Then, to set up and use your Linux system as a remote simulation server, use the information provided for UNIX systems.

System Requirements

Linux systems have the following requirements that are different from the UNIX systems described in “Check the System Requirements” on page 1-3:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Red Hat Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Red Hat Linux 7.3</td>
</tr>
<tr>
<td>Displays</td>
<td>High-resolution color only (Super VGA, 800x600, 15-inch monitor minimum).</td>
</tr>
<tr>
<td>CPU</td>
<td>Intel Pentium® class 200 MHz or higher.</td>
</tr>
<tr>
<td>Hard Disk Space</td>
<td>About 335 MB for a remote simulation server installation, depending on specific needs. Recommended file systems are FAT32 and NTFS. Novell file servers are not supported. VFAT/FAT systems are not recommended for complete installations.</td>
</tr>
<tr>
<td>Security Device</td>
<td>Advanced Design System software codewords are locked to an external device (FLEXid hardware security key) locked to a PC's LAN Ethernet card.</td>
</tr>
</tbody>
</table>
Installing ADS on Linux Systems

Only the ADS functionality that is required to support remote simulations is installed on Linux systems. When installing ADS on a Linux system, use the installation procedure in “Installation Steps” on page 2-3. Observe the following changes you should make during the installation:

• Use the Linux installation CD-ROM.

• If the CD-ROM is automatically mounted, and the contents are opened in a Nautilus window, do not run the SETUP command from the Nautilus window; use a terminal window. If you must mount the CD-ROM manually, an example Linux command is:

  mount -t iso 9660 /dev/cdrom /cdrom

• Choose to perform a Custom installation, and select the following components depending on the type of simulations you will run:

  • For Analog/RF, Momentum, and DSP simulations, select Simulators, Schematic Capture and Layout, and Vendor Component Libraries.

  • For Momentum planar electromagnetic simulations, also select Momentum Planar EM Simulator.

  • For DSP simulations, also select all of the Design Libraries.

  

  **Note**  Do not select any of the DesignGuides, Examples, or Documentation.

You are now ready to set up your Linux system as a remote simulation server. See “Setting up a UNIX Server” on page 5-4.
Setting up Your Simulation Server

Setting up a UNIX Server

To prepare a UNIX Server (remote computer), perform the following steps:

1. Log in to the remote computer.
2. Set the HPEESOF_DIR, PATH and DISPLAY environment variables as you normally would when running Advanced Design System.

   Note: DISPLAY has to be set if you are running Agilent Ptolemy simulations with TkPlots in them. This allows the server to display the TkPlots on the client machine.

3. Set the TCP communication port in the UNIX server in one of the following ways:
   - The communication port can be manually hard-coded in the hpeesof.cfg file. This might require root or super-user privileges to make the change (ask your IT department to help you). Open the hpeesof.cfg file located in <ADS_home>/config directory and add the following line to it:

     ```
     EEDAEMON_SOCKET = 1537
     ```

     If access to the IT department is slow, then create a new hpeesof.cfg file in your <home>/hpeesof/config directory and add the above line to it.

     While this socket is generally not used, make sure 1537 does not appear in /etc/services file. If it does, then choose another number for the socket (e.g., 5332).

   - The eedaemon line in /etc/services provides the communication port to hpremote. (See “Setting up Your Simulation Server” on page 5-4 and ask your IT department for help on setting it up.)

   - If EEDAEMON_SOCKET variable is not set to any port, then by default port 1537 will be assigned to it.
Note   Momentum requires an additional line in the hpeesof.cfg file, which is:
MOMENTUM_SIM_PATH=<remote_computer_name>
Refer to the Momentum manual in “Simulation” > “Performing Remote Simulations”.

4. Run the following script on the server:

    hpremote -d /tmp/remote_sim.log

    The -d option is for debugging purposes. It allows you to see the screen messages and save them in the remote_sim.log file for later verification. This file will be stored in the /tmp directory.

    If you get an error message, see “Simulator Server Error” on page 5-9 and “Remote Simulation Error” on page 5-9.

    To view the last part of the file, use the following command:

    tail -f /tmp/remote_sim.log

5. You can verify that the hpremote daemon is running by checking the process:

    ps -ef | grep hpeesofemx

Note   If another user has already launched the hpremote, then it must not be launched a second time. Subsequent remote users (you in this situation) can connect to this daemon as well. Make sure that the HPEESOF_DIR is set correctly for your simulation.
Setting up a PC Server

To prepare your PC server (remote computer) perform the following steps:

1. Set the TCP communication port in the server PC in one of the following ways:
   - The port can be manually hard-coded in hpeesof.cfg file. To do so, open hpeesof.cfg file located in `<ADS_home>\config` directory and add the following line to it:
     ```
     EEDAEMON_SOCKET = 1537
     ```
   - Or, create a new hpeesof.cfg file in `c:\users\default\hpeesof\config` directory and add the above line to it.

     If `EEDAEMON_SOCKET` variable is not set to any port, then by default, port 1537 will be assigned to it.

     **Note**  
     Momentum requires an additional line in the hpeesof.cfg file, which is:
     ```
     MOMENTUM_SIM_PATH=<remote_computer_name>
     ```
     Refer to the Momentum manual in “Simulation” > “Performing Remote Simulations”.

2. Start the Remote Simulation daemon with the command:
   ```
   <ADS_home>\bin\hpremote -d remote_sim.log
   ```
   from an MS-DOS shell or from the Windows > Start > Run menu.

   The `-d` option is for debugging purposes. It allows you to see the screen messages and save them in `remote_sim.log` file for later verification. This file will be stored in `<ADS_home>\bin`.

   **Note**  
   Do not terminate the MS-DOS window that pops up. Doing so will immediately terminate the daemon as well.

The Server (remote) PC is now ready to run ADS simulations started on a client.
Setting up a UNIX Client

It is recommended that you first edit the client's hpeesof.cfg file, located in the <ADS_home>/config directory to include:

```
EEDAEMON_SOCKET = 1537
```

Again, while this socket is generally not used, you should make sure 1537 does not appear in the `/etc/services` file. Also, even though 1537 is the default socket setting within ADS, best practices involve explicitly adding this line to the hpeesof.cfg file.

A client machine should now be ready to run remote simulation. Do the following:

1. Start ADS.
2. Open or create a project.
3. Open or create a design.
4. From the Schematic window, choose Simulate >Simulation Setup.
5. In the dialog box that appears, type in the Host name (or Host's IP address) in the Remote Simulation Host field.
6. Click on Simulate.

If Remote Simulation succeeds, the Status window will open and show the progression of the simulation.

Whether you need any other setup on the client depends on user preferences and if an OPEN_SIMULATOR error message occurs, see “Simulator Server Error” on page 5-9.
Multiple servers may be available on your system. Multiple servers are particularly useful when you intend to compare circuit simulation results as quickly as possible. Once multiple servers are set up, they can be accessed by typing in each name at a client computer, or by generating a listing on a client.

This listing appears when you click the down arrow next to the Remote Simulation Host field. Normally this is a list of one, defaulting to local and no others. However, you may write a list of hosts into the de_sim.cfg file on a client computer. Edit the de_sim.cfg file, located in your <ADS_home>/config directory, or c:\users\default\hpeesof\config (on PC) or <home>/hpeesof/config (on UNIX) directory, to include the following line:

```
SIMULATION_HOST_LIST=[hostname1] [hostname2]...
```

where each [hostname] must be separated by a single space. After making this edit, start ADS. From the Schematic window, choose Simulate > Simulation Setup. In the dialog box that appears, click the down arrow just to the right of the Remote Simulation Host field, highlight the host you want, and click the Simulate button.

**Scripting**

You may want to automate the startup of the EMX daemon each time the workstation boots. This can be done through a resource configuration (RC) script such as the following.

**Example of RC Script**

The following is an example entry to start hpremote setup:

```
HPEESOF_DIR=<your installation directory path>
PATH=$HPEESOF/bin:$PATH
if [ -f $HPEESOF_DIR/bin/hpremote ]; then
    hpremote -d /tmp/remote_sim.log & fi
```
Simulator Server Error

For either a PC or UNIX Server, if you get the following error message when running Remote Simulation on the client:

(send_server_command) OPEN_SIMULATOR
server error

The EMX daemon may not be running on the Server. Check the Server:

- **PC** Try using hpremote -d <filename> to start the daemon. If a failure re-occurs, you can check the log file <filename> saved in the <ADS_home>/bin directory to search for causes. On the client side, try typing in the Server’s IP address instead of its machine name in the Remote Simulation Host field of the box that pops up from Simulate > Simulation Setup.

- **UNIX** Please be sure you edited and ran hpremote as described above. Remember that adding EEDAEMON_SOCKET = 1537 to hpeesof.cfg is recommended before running hpremote.

- **PC and UNIX** If you are sure hpeesofemx is running on the Server, it may be listening to a different socket address than the client seeks. Please verify that both client and Server computers are using the same TCP socket. It is recommended to use socket 1537, the default setting in ADS sought by clients.

Remote Simulation Error

For remote simulations using a UNIX server, if you receive an error message such as the following when running the hpremote script:

[1] + Stopped (tty output) -hpeesofemx-d remotelog &

this might be an indication that you are running from a shell that does not write messages to tty for a background process (tty gets the terminal name).

In this situation, use the following command in the hpremote script:

```
  hpeesofemx 2>&1 &
```

Note that this message also appears if you are using remote simulation with Momentum.
Using Remote Simulation

Ending Remote Operation

Use the following steps to end a remote operation.

1. On the local machine, exit Advanced Design System.
2. Terminate the hpeesofemx daemon that is running on the remote server. In Windows, go to the Task Manager and End the Process.
   In UNIX, to find the process do:
   
   ps -ef | grep hpeesofemx
   
   and then kill the process as follows:
   
   kill -9 <process ID>
   
   The next time Advanced Design System is launched, it will default to simulate locally again.

Remote Simulation Restrictions

Please note that the following restriction applies to remote simulation:

In the Momentum simulator, if a substrate computation is required, you must set the <ADS_home>/momentum/lib/substrates directory and the files under it accessible for reading and writing. However, if you do not do this, the program will warn you.
Defining the EMX Daemon Remote Address

Remote simulation requires fixed socket addresses for the client(s) and server(s) computers. By default, the EMX daemon started by the hpremote script uses a socket address of 1537. However, relying on this default setting may or may not result in a successful remote simulation. Thus, it is recommended to explicitly set the socket address by one of the two options below:

- **Edit** the `<ADS_home>/config/hpeesof.cfg` file for each client(s) and server(s) computer (PC or UNIX) to include:

  ```
  EEDAEMON_SOCKET = xxxx
  ```

  where `xxxx` is a port number not in use by the `/etc/services` file or the Windows Services (for instance `xxxx` could be “1537” if that port is free). This socket address should be known and fixed across all associated platforms (client(s), host(s) ...).

- **Edit** the `/etc/services` file to set a socket address for EEDAEMON, such as

  ```
  eedaemon xxxx/tcp eedaemon
  ```

  where `xxxx` is a number such as 1537 or 5332. This method is useful in a multi-node environment. However, the `/etc/services` entry must be identical on every node. This approach has greater power, but requires root or super-user privileges to make the change. If access to a system administrator is slow, it may be overall easier to use the first option.
Using Remote Simulation

Using LSF Remote Simulation

This section describes how to use LSF to perform remote simulations on one or more remote simulation servers.

LSF (Load Sharing Facility) from Platform Computing is a facility that enables remote simulations with dynamic host selection. ADS 2003 integrates this facility to enable automatic remote host selection. Simple swept simulations can also be configured to utilize many available machines on the network. We call this feature parallel simulation. A simple sweep can be setup to run on a set of machines. LSF is used to select the best machine set. Individual sweep points are run on each machine and results combined into a single dataset on the local machine.

For a machine to participate as a “fastest host” or in a parallel simulation it must have both LSF and ADS 2003 installed. ADS also needs configuration changes to tell it what hosts are available. The feature is configured using the status server configuration file, hpeesofsess.cfg.

Note Momentum Electromagnetic simulator does not support LSF remote simulation.
LSF Requirements

Supported Operating Systems for Use as a Server (Host):
  • UNIX systems

Supported Operating Systems for Use as a Client (Local Computer):
  • UNIX systems
  • Windows NT/2000/XP

Supported LSF Software:
  • LSF Standard Edition 4.1 or higher

Where to Get LSF Software:
  www.platform.com

Where to Get LSF Documentation:
  www.platform.com/services/support/docs_home.asp
  (requires password)

Note  LSF is used largely to determine suitable hosts for remote simulations. Many of the LSF features, like queuing and priorities, are unused in this release.

Security

Security is minimal. It is assumed that ADS and LSF are being used in a trusted environment. It is possible to accidentally use a different user’s UNIX account when simulating.

Recommendations For Use

• For UNIX, all users (who will be using ADS and LSF) must have a common, shared, $HOME directory, on all systems. Note that, not only must the same $HOME directory name be used on all systems, but the same directory must be used (typically, the same directory is mounted via NFS in the same location on all systems). In other words, if a file in a user’s $HOME directory is changed on one system, that change must be immediately reflected on every other system.
Using Remote Simulation

- Keep at least 100 MB of free disk space be available on each system for use by temporary simulation data (the more, the better).
- It’s also strongly recommended that the disk space be on a local disk, as opposed to a network (NFS) disk. While network disks can be used, a significant simulation performance degradation can be seen if network disks are used. For best performance, the free disk space should be on a disk local to each system. This last statement is not in conflict with the requirement about $HOME directories. $HOME directories must be shared (and, therefore, be on a network drive), but temporary disk space should be on a local disk.

Setting Up LSF and ADS

Use the steps in the following sections to set up LSF and ADS.
Preliminary Setup

The following preliminary steps should be taken:

1. Follow the LSF instructions to set up LSF at your site. Note that LSF servers must be running on every system that you want to use as a possible simulation host. LSF clients must also be running on every system on which ADS will be running. If LSF is not running, ADS will not be able to perform LSF-managed simulations.

2. Install ADS on every UNIX system that you want to use as a possible LSF remote simulation host, and install ADS into the same location on each host (or use a symlink at the same location to point to where you actually installed ADS). Alternatively, you can install ADS on one or more centralized servers, and have each UNIX system access ADS via NFS and symlinks.

   All systems must be able to access ADS using the same directory path. Use symlinks, if necessary, to meet this requirement.

Setting Up Scripts on Each LSF Remote Host

Scripts on each LSF remote simulation host must be configured (if ADS is installed on centralized servers, the following need only be done on each centralized server). Do the following for each remote simulation host:

1. First, determine a location for a temporary work directory. The default is /tmp. You can use /tmp or /var/tmp, or some other convenient directory. However, you must have enough disk space at this location to hold the data for each LSF-managed intermediate simulation. Be sure this is a local disk with at least 100 MB of free disk space. If you plan on performing large simulations, you’ll need more disk space (the more, the better).

   While you do not have to use the same directory location on each LSF remote simulation host. However, using the same directory location (using symlinks if necessary) will greatly simplify configuration in the following steps.

2. Copy the file, “$HPEESOF_DIR/sess/remote-sim-server”, to “$HPEESOF_DIR/custom/config/remote-sim-server” (this destination file should not already exist). Example:

   cd $HPEESOF_DIR/sess
   cp remote-sim-server ..;/custom/config/remote-sim-server
3. The newly copied file, 

```
$HPEESOF_DIR/custom/config/remote-sim-server
```

is a plain shell script. Edit this file and appropriately change the settings of the 

```
"HPEESOF_DIR"
```

environment variable to match the correct HPEESOF_DIR value for the current host.

You must explicitly set the value for HPEESOF_DIR. You cannot rely upon the 

HPEESOF_DIR environment variable being properly set when this script is 

run due to the way in which ADS executes this script.

(If the HPEESOF_DIR variable is set, it will have the value of HPEESOF_DIR 

for the system on which the ADS graphical user interface is running. This may 

not be the correct value for HPEESOF_DIR on the remote simulation host, 

which is the host on which this script will be run.)

In this script, the default value for HPEESOF_DIR is “/dev/null”, which is 

clearly incorrect; this value was chosen to emphasize the fact that this script 

must be edited.

Note that this script allows different platforms (HP-UX, and SunOS) to have 

different values for HPEESOF_DIR; make sure that you edit the correct 

occurrence of HPEESOF_DIR for the current platform.

You must also change the first line of the newly copied file from “# /bin/sh” to 

“#!/usr/bin/sh”.

4. Make sure that the newly copied file has execute permission, for example:

```
chmod 555 $HPEESOF_DIR/custom/config/remote-sim-server
```
Editing ADS Configuration Files

Next, on each LSF remote simulation host, one or more ADS configuration files must be edited (if ADS is installed on centralized servers, the following need only be done on each centralized server).

The configuration can be controlled on a system-wide or per-user basis. System-wide configurations affect all users on a system, but are simple to configure; only one file needs to be edited. Per-user configurations affect only a single user, and take precedence over any system-wide configurations; however, you’ll have to configure a file for each user. You’ll have to decide which is best for you. However, most users will be satisfied with a system-wide configuration.

1. To set a system-wide configuration, edit (create) the following file, and use steps 2 through 4 to set values in it:

   `$HPEESOF_DIR/custom/config/hpeesofsess.cfg`

   To set the configuration for a single user, edit (create) the following file, instead, and use steps 2 through 4 to set values in it:

   `$HOME/hpeesof/config/hpeesofsess.cfg`

2. By default, LSF-controlled simulations will use all available LSF hosts for remote simulations, and every available host will be used for each simulation. For some sites, there may be issues with this:

   • This assumes that ADS is installed/available on all LSF hosts. Some sites may have ADS installed/available on only a subset of LSF hosts.

   To restrict simulations to a subset of LSF hosts, you must create a list of hosts to which LSF simulations may be submitted. See step 4 in this section, below, for instructions on how to set the LSF_HOSTFILE variable.
Using Remote Simulation

- Some sites may want to limit the number of hosts that a single simulation can use.

To limit the number of LSF hosts that a single LSF simulation will use, you must set the variable LSF_MAX_HOSTS. Example:

```
LSF_MAX_HOSTS = 17
```

This will impose a limit of 17 hosts when performing a single LSF simulation. Note that this limit applies to each user's simulation. For example, if two users have a limit of 17, and both perform LSF-controlled simulations, the maximum number of systems used is 34, and not 17.

If you need to limit both the hosts and the number of hosts, both methods can be used simultaneously.

3. You must tell ADS the location of the “remote-sim-server” script (from the section on scripts, above) on the remote systems. You do this by setting the variable REMOTE_SIM_SERVER.

Example: If you installed ADS on the remote systems such that

```
HPEESOF_DIR=/ADS_170,
```

you would add this line to the configuration file (without leading spaces):

```
REMOTE_SIM_SERVER = /ADS_170/custom/config/remote-sim-server
```

Do not use any environment variables when setting this variable; you must use the actual, absolute path name. In other words, do not use a line such as:

```
REMOTE_SIM_SERVER = $HPEESOF_DIR/custom/config/remote-sim-server
```

This will not work, and will only cause problems.

4. If you did not choose / tmp as the temporary work directory (for all systems) in step 1 in the section on scripts, above, you will have to tell ADS about this. If all systems will be using / tmp, you can skip this step.

You can specify a different temporary work directory for each remote simulation host, or you can specify that the same directory path is to be used on each host.

If you want to specify the same temporary work directory path for all remote simulation hosts, you do so by placing a line like the following into the hpeesofsess.cfg file:

```
LSF_TMPDIR = /my/tmp/dir
```
Replace /my/tmp/dir with the desired name of the temporary work directory. By setting LSF_TMPDIR, you are specifying that this directory path is to be used as the default temporary work directory on all remote simulation hosts.

If all systems will be using the same path specified by LSF_TMPDIR, you can skip the rest of this step.

If you need to restrict LSF simulations to a subset of LSF hosts, or if you want to specify different temporary work directory names for some or all of the remote simulation hosts, you must create a file that lists each remote simulation host and the corresponding temporary work directory (if different from the default). However, if you create this file, note that only the systems listed in this file will be used by LSF-controlled simulations.

This file is specified using the variable LSF_HOSTFILE. Example:

```
LSF_HOSTFILE = /my/path/to/some/hostfile
```

This file can have any name, and it consists of text lines of the form:

```
<system_name> [ <temporary_directory_name> ]
```

Where:

- `<system_name>` is the name of a remote simulation host, including domain name. In other words, the name must be a fully qualified domain name (FQDN).

Note that all systems must be within your local domain (the same domain as the system from which ADS is run). You cannot specify systems that are not within your local domain. If you do, ADS may not work properly.

- `<temporary_directory_name>` is the optional name of the temporary directory to use on the remote simulation host. If this directory is not specified, the value of LSF_TMPDIR will be used, or, if LSF_TMPDIR is not set, /tmp will be used.

Example (assuming that your domain name is “qptzx.com”):

```
system1.qptzx.com /tmp
system2.qptzx.com /disk2/tmp
system3.qptzx.com
system4.qptzx.com /some/disk/foo
```

Note that system3 does not have an explicit temporary directory; since one is not specified, the value of LSF_TMPDIR will be used or, if LSF_TMPDIR is not set, /tmp will be used. As only four systems are specified here, the maximum
number of LSF-controlled simulations is four (even though there may be more LSF-managed hosts available).

As mentioned above, only the systems listed in this file will be used for LSF-controlled simulations, and so you must insure that all systems that you want to use are listed here.

Also, make sure that all temporary working directories are writable.

The following is an example of an lsf_hosts.cfg file:

```
#this is my LSF control file
#Date:8/12/2003

#sirpoh will use /tmp
server.yourcompany.com /tmp

#no directory specification => jane will use * => /tmp/parallel.
jane.server.yourcompany.com

#joe will use /users/poh/tmp
joe.server.yourcompany.com /users/poh/tmp

#generic temporary directory specification on a host line
* /tmp/parallel
```
Configuring Each ADS User

Each user running ADS needs to be configured. Basically, each user needs to use a different port number for LSF-controlled simulations, and this port number must be manually chosen, and manually checked to insure that the port number is not being used by any other user.

Note that the port number must be unique. If two or more users share the same port number, it's quite likely that one user will end up performing LSF simulations as another user.

Once the port number is chosen, the rest of the procedure is simple. For each user, from a shell prompt, do the following:

```
mkdir -p $HOME/hpeesof/config echo "EEDAEMON_SOCKET=12345" >> $HOME/hpeesof/config/hpeesof.cfg
```

Replace “12345” with the chosen port number.

Checking the User’s $PATH

Before running ADS, the path to the LSF programs must be in each user’s $PATH. To verify that LSF is in $PATH, you can run the lshosts command as a test, for example:

```
lshosts
```

Here, lshosts should print a list of available LSF-managed hosts.
Using Remote Simulation
Index

C
codewords
  backward compatibility, 3-31
  installing, 3-2
Connection Manager, 2-19

F
FLEXlm licenses
  setting up, 3-1

I
installation
  completing requirements, 4-1
  custom, components, 2-10, 2-11
  requirements, 1-3
  to multiple disks or directories, 2-16

L
license.lic file
  updating, 3-23
licenses
  bundles, 4-1
  changing path settings, 3-27
  multiple ADS licenses, 3-32
  packages, 4-1
  setting bundle preference, 4-1
  setting up, 3-1, 4-1

M
memory
  checking, 1-7

O
operating system
  checking, 1-5
  requirements, 1-3, 5-2

P
printing and plotting, setting up, 4-15, 5-1

S
support, 4-20

T
technical support, 4-20